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Release notes
Article • 2/25/2026 • 2 min read

To view what's new or changed in each release of the Aptean Pack and Ship extension, select the specific release.

Date Release version Description

February 2026 2601.1.0.0 Stability release

January 2026 2601.0.0.0 Feature release

November 2025 2503.6.0.0 Stability release

October 2025 2503.5.0.0 Stability release

September 2025 2503.4.0.0 Platform release

September 2025 2503.3.0.0 Stability release

August 2025 2503.2.0.0 Stability release

August 2025 2503.1.0.0 Platform release

July 2025 2503.0.0.0 Feature release

July 2025 2502.1.0.0 Stability release

May 2025 2502.0.0.0 Feature release

February 2025 2501.0.0.0 Feature release

December 2024 2403.7.0.0 Stability release

December 2024 2403.6.0.0 Stability release

December 2024 2403.5.0.0 Stability release

December 2024 2403.4.0.0 Stability release

October 2024 2403.3.0.0 Stability release

October 2024 2403.2.0.0 Platform release

October 2024 2403.1.0.0 Stability release

September 2024 2403.0.0.0 Feature release

August 2024 2402.9.0.0 Stability release
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July 2024 2402.8.0.0 Stability release

June 2024 2402.7.0.0 Stability release

June 2024 2402.6.0.0 Stability release

June 2024 2402.5.0.0 Stability release

June 2024 2402.4.0.0 Stability release

May 2024 2402.3.0.0 Stability release

April 2024 2402.2.0.0 Stability release

April 2024 2402.1.0.0 Stability release

March 2024 2402.0.0.0 Feature release

February 2024 2401.0.0.0 Feature release

February 2024 2302.2.0.0 Stability release

January 2024 2302.1.0.0 Stability release

November 2023 2302.0.0.0 Feature release

October 2023 2301.1.0.0 Stability release

September 2023 2.12.117494.0 Feature release

May 2023 2.11.100815.0 Stability release

March 2023 2.10.83682.0 Feature release

February 2023 2.9.83035.0 Stability release

November 2022 2.8.67023.0 Stability release

August 2022 2.7.55516.0 Stability release

May 2022 2.6.48324.0 Stability release

April 2022 2.6.47119.0 Feature release

September 2021 2.3.212725.0 Stability release

April 2021 2.2.210996.0 Feature release
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2601.1.0.0
Release Note • 2/25/2026 • 1 min read

Enhancements/Modifications
With this release of the Aptean Pack and Ship extension, changes have been made to replace the
OnBeforePostSourceDocument event with OnBeforePostSourceHeader in PnS Event Management BCW, added the
SetPostingShippingBatchNoFromWarehouse procedure to PackandShipSubscribersMgtBCW, and moved the
OnBeforeSalesLineModify event subscriber from the Whse.-Post Shipment codeunit to the Sales Whse. Post Shipment
codeunit.

Resolved issues
The following issue has been resolved in this release.

ID Description

350047
The system fails to update the Shipping Batch Number field value on sales shipments when executing
the Post action for packages with non-warehouse locations.
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2601.0.0.0
Release Note • 1/28/2026 • 1 min read

Enhancements/Modifications
With this release of the Aptean Pack and Ship extension, the deprecated PermissionManagementBCW and
ProfileManagementBCW codeunits have been removed and replaced with ShipPermissionManagementBCW and
ShipProfileManagementBCW, respectively, to avoid naming conflicts when using the Aptean EDI extension.

https://fnbdocs.apteancloud.com/bc/docs/EDI/aptean-edi-overview/
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2503.6.0.0
Release Note • 11/11/2025 • 1 min read

Enhancements/Modifications
With this release of the Aptean Pack and Ship extension, the system supports both QA and demo environments in
the Aptean Ship tenant. The data is shared with the corresponding environment based on the value selected in the
Environment field on the Aptean Pack and Ship Setup page. Additionally, the API Base URL field value is
automatically updated based on the selected environment.

Note

The following options will be added in a future release: - Integration Dev
- Performance
- Security
- UAT

UI/UX changes
The QA and Demo options have been added to the Environment field on the Aptean Pack and Ship Setup page.



Aptean Pack and Ship

Page 10 of 159

2503.5.0.0
Release Note • 10/29/2025 • 1 min read

Enhancements/Modifications
With this release of the Aptean Pack and Ship extension, the system includes the number of packages value when
the shipping batch is sent through the Aptean Ship API call, providing the number of cartons when the Aggregate
action is executed for packages. This enhancement addresses the issue reported in bug ID #336423.

Resolved issues
The following issues have been resolved in this release.

ID Description

336423
The system fails to update the number of packages when processing packages on the Warehouse
Packaging page using the Aggregate action.

335037
The system fails to update the dimension-related field values such as Height, Length, Width, and
Cubage on the Package page when the related Carton Type Code field value on the Pack Scanning
page is entered manually.
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2503.4.0.0
Release Note • 9/25/2025 • 1 min read

Enhancements/Modifications
With this release of the Aptean Pack and Ship extension, the Package, BatchPack, and PackagingType variables have
been moved from the var section to the protected var section on the Warehouse Packaging BCW page, improving
security of the functionality.
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2503.3.0.0
Release Note • 9/11/2025 • 1 min read

Resolved issues
The following issue has been resolved in this release.

ID Description

323238
An error occurs when executing the Pack and Ship action on the Warehouse Shipment page if the
associated shipping agent service has the same code for multiple shipping carrier service codes.
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2503.2.0.0
Release Note • 8/27/2025 • 1 min read

Resolved issues
The following issues have been resolved in this release.

ID Description

316184

The system incorrectly removes the Shipping Agent Code and Shipping Agent Service Code field
values on the Sales Order page. This issue occurs when a combined warehouse shipment is created via
the Shop Floor Activity screen for multiple sales orders with the different Shipping Agent Code and
Shipping Agent Service Code field values.

316185
An error occurs on the Warehouse Shipment page when trying to create a package using a number
series name that contains more than 10 characters.
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2503.1.0.0
Release Note • 7/30/2025 • 1 min read

Enhancements/Modifications
With this release of Aptean Pack and Ship extension, the NoSeriesManagement codeunit has been replaced with the
standard No. Series codeunit on the Whse.-Post Packages, Carrier Detail, Package Carton, Package Header, Shipping
Batch and bcPacknShip Setup tables to ensure compatibility with Business Central, version 27.
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2503.0.0.0
Release Note • 7/30/2025 • 2 min read

Features
With the feature added in this release of the Aptean Pack and Ship extension, the system displays only the
ApteanShip option in the Shipping API field on the following pages and the EasyPost option has been deprecated.

Shipping API Setup

Shipping Carriers

Shipping Carrier Service Level

Ship Setup

Shipping Carrier Service Level Buffer

UI/UX changes
The EasyPost option has been removed from the Shipping API field on the following pages:

Shipping API Setup

Shipping Carriers

Shipping Carrier Service Level

Ship Setup

Shipping Carrier Service Level Buffer

Resolved issues
The following issues have been resolved in this release.

ID Description

299586
The system incorrectly updates the Third Party Shipping Account No. field value with the No. field
value of the Third Party Shipping Accounts page, even though the Account No. field has a value.

308934
The system incorrectly creates a separate shipping batch for each package when the Residential
checkbox is selected on the Shipping Agent Services page for the selected shipping agent, instead of
grouping them as single batch per sales order.
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314206
The system incorrectly updates the Shipping Agent Code and Shipping Agent Service field values on
the Pack Scanning page by inheriting them from the Warehouse Shipment page instead of the related
Sales Order page, resulting in the shipping batch being posted with incorrect shipping details.
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2502.1.0.0
Release Note • 7/3/2025 • 1 min read

Resolved issues
The following issues have been resolved in this release.

ID Description

287165
An error occurs on the Warehouse Shipment page when attempting to post it. This issue arises when
the Underdelivery checkbox in the warehouse shipment line is selected.

307015
The system incorrectly filters the line from the Pack Scanning page after a value is entered in the
Weight field and only reappears after navigating back from the associated Warehouse Shipment page.
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2502.0.0.0
Release Note • 5/20/2025 • 1 min read

Features
With the features added in this release of the Aptean Pack and Ship extension,

The system updates the Shipment Status and Shipment Status Message field values after executing the Ship
action on the Shipping Batch page based on the response of the associated batch. Additionally, you can view
these field values on the associated fields on the Posted Shipping Batch page after posting it.

You can view the PRO#, B/L#, Expiry Date, and Batch field values on the UCC Package Level 5 report and the
values are inherited as below:

Field in the UCC Package Level 5 report Value inherited from

PRO#
The Tracking No. field value on the Package page linked to the
related Shipping Batch page.

B/L#
The Sales Order No. field value on the Package page linked to
the related Shipping Batch page.

Expiry Date
The Expiration Date field value of the associated lot. If there
are multiple lots, it is updated as MIXED.

Batch
The Lot No. field value of the associated lot. If there are
multiple lots, it is updated as MIXED.

UI/UX changes
The following UI/UX changes have been made in this release.

The Shipment Status and Shipment Status Message fields have been added to the Posted Shipping Batch
page.

The PRO#, B/L#, Expiry Date, and Batch fields have been added to the UCC Package Level 5 report.
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2501.0.0.0
Release Note • 2/11/2025 • 1 min read

Features
With this release of the Aptean Pack and Ship extension, the Reference2 and Reference3 field values on the Carrier
Details Card page are mapped and included in the API request.

Resolved issues
The following issue has been resolved in this release.

ID Description

263948
The system incorrectly updates the Unit Price field value on the lines of the Package page when
created via the Warehouse Shipment page.
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2403.7.0.0
Release Note • 12/18/2024 • 1 min read

Enhancements/Modifications
With this release of the Aptean Pack and Ship extension,

The shortcut keys for Ship and Ship and Post actions on the Pack Scanning page have been updated to avoid
conflicts with browser shortcuts.

The number of shipments that can be sent per batch on the Ship Setup page has been changed from 30 to 20.

The Writeback To Source toggle on the Aptean Pack and Ship Setup page is not visible by default. However,
you can make it visible through personalization.

Certain tooltips on the Ship Setup and Aptean Pack and Ship Setup pages have been curated for better
guidance and readability.

The character limit of the reference fields on the Carrier Details Card page, associated with the Shipping Agents
page, has been limited to 35 characters.

UI/UX changes
The following UI/UX changes have been made in this release.

The WriteBack To Source toggle has been made hidden on the Aptean Pack and Ship Setup page.

The error message associated with exceeding character limit on the Carrier Details Card page has been
removed.

The shortcuts for the following actions on the Pack Scanning page have been changed.

S.No Action Previous shortcut key Updated shortcut key

1 Ship Ctrl+Alt+E Ctrl+F8

2 Ship and Post Ctrl+Shift+E Ctrl+F7
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2403.6.0.0
Release Note • 12/16/2024 • 1 min read

Enhancements/Modifications
With this release of the Aptean Pack and Ship extension, you can:

Define the number of shipments that can be sent per batch on the Ship Setup page.

Send multiple batches from the Warehouse Shipments page using the Pack and Ship Batch or Pack, Ship Batch
and Post actions.

Define the runout time for the request in the Request Timeout in Seconds field on the Aptean Pack and Ship
Setup page.

Configure whether additional information needs to be received from the ship API.

UI/UX changes
The following UI/UX changes have been made in this release.

The Pack and Ship Batch and Pack, Ship Batch and Post actions have been added to the Warehouse Shipment
page.

The No. of Shipments per Batch field has been added to the Ship Setup page.

The Request Timeout in Seconds field and the Writeback To Source toggle have been added to the Aptean
Pack and Ship Setup page.
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2403.5.0.0
Release Note • 12/12/2024 • 2 min read

Enhancements/Modifications
With this release of the Aptean Pack and Ship extension,

When you execute the Pack and Ship action on the Warehouse Shipment page, the system will display the
confirmation message based on the value selected in the Whse. Pack & Ship Confirmation field on the Ship
Setup page as follows:

None: No confirmation message

All Whse. Shpt. Lines: A confirmation message per warehouse shipment

Each Whse. Shpt. Line: A confirmation message for each warehouse shipment line

The system creates different packages for the lines on the Warehouse Shipment page based on the Source No.
field value instead of creating a combined package for all the lines in a warehouse shipment.

You can navigate to the Warehouse Packaging or Sales Packaging page directly from the Pack Scanning page
by executing the Packaging (View > Packaging) action.

UI/UX changes
The Packaging action has been added to the Pack Scanning page.

Resolved issues
The following issues has been resolved in this release.

ID Description

242849
The system incorrectly updates the Carton Type field on the Package page after scanning the items on
the Pack Scanning page and does not inherit the values and rules from the associated Packaging Rules
page.
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2403.4.0.0
Release Note • 12/2/2024 • 3 min read

Enhancements/Modifications
With this release of the Aptean Pack and Ship extension,

The shortcut keys for certain actions on the Pack Scanning page have been updated to avoid conflicts with
browser shortcuts.

You will receive the following confirmation messages upon executing the Pack and Ship action on the
Warehouse Shipment page based on the option selected in the Whse.Pack & Ship Confirmation field on the
Ship Setup page.

Whse. Pack & Ship Confirmation field value Result

None
No confirmation message appears. The system processes
the shipment directly.

All Whse Shipment Line
A single confirmation message appears for all warehouse
shipment lines.

Each Whse Shipment Line
A confirmation message appears for each warehouse
shipment line.

The user experience has been optimized to improve the process of closing the Package Type page.

The Batch Pack toggle on the Pack Scanning page is turned on/off automatically based on the value of the
Batch Pack Default toggle on the Ship Setup page.

The system performs shipping and posting of shipping batches automatically when you select the Ship and Post
action on the Pack Scanning page.

You can print the batch shipping and package shipping documents from the Shipping Batch and Package (list
and card) pages respectively using the Print Shipping Docs action.

Some of the hidden fields on the Shipping Agents page have been made visible by default.

You can define if the system should display the notification message after the shipment is completed for
shipping batches posted via the Carrier > Ship action on the Shipping Batch page.
Additionally, you will receive only a single notification message if the Completion Message on Ship toggle on
the Ship Setup page is turned on, even when multiple shipping batches are posted.
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UI/UX changes
The following UI/UX changes have been made in this release.

The shortcuts for the following actions on the Pack Scanning page have been changed.

S.No Action Previous Shortcut Key Updated Shortcut Key

1 Labels Ctrl+G Ctrl+G+F10

2 Reopen & Pkg. Ctrl+B Ctrl+Shift+B

3 Get Weight Ctrl+W Ctrl+Shift+F9

4 Shipping Batch Ctrl+F Ctrl+F1

The shortcut keys for the Close Pkg., Release All, and Release and Ship actions have added as Ctrl+M, Ctrl+\
and Ctrl+F2 respectively, on the Pack Scanning page.

The Package Type page can be closed using the Enter key on the keyboard.

The Ship action has been added to the Pack Scanning page.

The Batch Pack Default toggle has been added to the Pack FastTab of the Ship Setup page.

The Completion Message on Ship toggle has been added to the Ship Setup page.

The Ship and Post action has been added to the Pack Scanning page.

The Print Shipping Docs action has been added to the Shipping Batch and Package (list and card) pages.

The Default Domestic Service, Default Residential Service, Default Canadian Service, and Default International
Service fields on the Shipping Agents page have been made visible by default.

Resolved issues
The following issues have been resolved in this release.

ID Description

237280 An error occurs upon executing the Get Weight & Close Pkg. action on the Pack Scanning page.
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243968

The system fails to display the cursor in the Source Document No. field while opening the Pack
Scanning page.

The system fails to update the fields in the FactBox when scanning the second order.

The system incorrectly moves the cursor to the blank line while closing the Pack Scanning page.
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2403.3.0.0
Release Note • 10/21/2024 • 2 min read

Enhancements/Modifications
With this release of the Aptean Pack and Ship extension, you can:

View the Packing/Shipping Station No. field on the Warehouse Employees page. You can select the field value
from the lookup table associated with the scale codes.

View pack station details on the Pack Scanning page in fields such as Location Code, Pack Station Code, and
Scale Code. The Pack Station Code and Scale Code fields are populated based on the selected Location Code
field. You can manually edit the Location Code field if the Pack Scanning page is opened through the Tell Me
function, but it is uneditable when opened through the Warehouse Shipment page.

UI/UX changes
The following UI/UX changes have been made in this release.

The Pack Station group has been added to the Pack Scanning page.

The Packing/Shipping Station No. field has been added to the Warehouse Employees page.

The Scale Code field has been added to the Packing/Shipping Stations page, and all other fields such as Scale
Computer ID, Scale Computer Name, Scale Device ID, and Scale Device Name fields have been made obsolete.

Resolved issues
The following issues have been resolved in this release.

ID Description

238532
The system fails to update the shipping agent and carrier service details on source documents, such as
sales orders, warehouse shipments, and pack scanning, when the corresponding field values are
modified on the Shipping Batch page.

238892
The system incorrectly selects the first location on the Warehouse Employees list page, even when the
Default checkbox is selected for other lines, when determining the packing or shipping station.
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2403.2.0.0
Release Note • 10/16/2024 • 1 min read

Enhancements/Modifications
The WhseActivityCreate codeunit has been replaced with PurchasesWarehouseMgt, SalesWarehouseMgt,
ServiceWarehouseMgt, and TransferWarehouseMgt codeunits to ensure compatibility with Business Central, version
26.
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2403.1.0.0
Release Note • 10/1/2024 • 1 min read

Enhancements/Modifications
With this release of the Aptean Pack and Ship extension, the system displays a single consolidated message instead
of individual messages for each shipping batch. This happens when the warehouse shipment includes multiple sales
order lines, resulting in the creation of multiple batches during the execution of the following actions on the
Warehouse Shipment page.

Pack and Ship

Pack, Ship and Post

Resolved issues
The following issue has been resolved in this release.

ID Description

232246

The system updates the tracking number only for the first line on the Shipping Batches page and fails
to update it for the remaining lines. This issue occurs when the warehouse shipment includes multiple
sales order lines, and the following actions are executed on the Warehouse Shipment page.

Pack and Ship

Pack, Ship and Post
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2403.0.0.0
Release Note • 9/3/2024 • 1 min read

Features
With this release of the Aptean Pack and Ship extension, you can choose the item number as a default reference on
the Carrier Detail Card page. Once the sales order is packed and shipped, the system groups all item numbers from
the associated sales order lines into the reference field. For example, if a sales order includes items 0011, 0012, and
0013, the reference field will display 0011, 0012, 0013. For more information, see Default Service Details.

UI/UX changes
The Item No. option is added to the Default Reference 1, Default Reference 2, and Default Reference 3 fields on the
Carrier Detail Card page.
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2402.9.0.0
Release Note • 8/21/2024 • 1 min read

Enhancements/Modifications
With this release of the Aptean Pack and Ship extension, modifications have been made to accommodate the
following changes:

Enhanced application interaction: Procedures have been added to enhance the application interaction, improve
upgrade tag management, streamline upgrade and installation processes, and provide additional flexibility by
managing upgrades on a per-company and per-database basis.

Application area refresh: Updates have been implemented to improve the application area refresh process by
integrating a new procedure into the Enable codeunit.

Improved management of install and upgrade code: The Install and Upgrade codeunits have been updated to
streamline the handling of installation, reinstallation, and upgrade processes, ensuring smoother transitions and
minimizing disruptions during these operations.

Centralized license management procedures: The existing license management codeunit has been modified to
use centralized license management procedures, further reducing the need for application-specific adjustments.

Enhancements have been made to update the process within the application to handle the User Group and User
Group Permission Set tables. This change ensures compatibility with current and future versions of Business
Central, even when the User Group and User Group Permission Set tables are deprecated.

Note

The User Group and User Group Permission Set tables are deprecated in Business Central, version 25.
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2402.8.0.0
Release Note • 7/11/2024 • 1 min read

Enhancements/Modifications
With this release of the Aptean Pack and Ship extension, the system inherits the shipment date in the shipment
batch from the associated source document. Updating the shipment date in the source document will prompt you
to update the date on the Shipping Batch page, and vice versa. This enhancement resolves issues reported in bug
ID #213264.

Note

You cannot modify the shipment date once the Ship action is executed on the Shipping Batch page.

Resolved issues
The following issues have been resolved in this release.

ID Description

213264

The system fails to inherit the Shipping Date field value on the Warehouse Shipment page from the
associated sales order upon executing the Pack and Ship action.

The Shipment Date field value remains uneditable on the Shipment Batch page if not shipped, failing
to prompt updates to related package headers when modified.
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2402.7.0.0
Release Note • 6/12/2024 • 1 min read

Enhancements/Modifications
With this release of the Aptean Pack and Ship extension, modifications were made to accommodate the following
scenarios:

When creating a shipping batch from a sales order or warehouse shipment, the Shipment Date field value is
displayed on the associated Shipping Batch page.

When executing the Ship action on the Shipping Batch page, the system maps the Shipment Date field value to
the Ready Date field value in the Shipment Status group of the Aptean Ship portal.

When modifying the Ready Date field value on the Aptean Ship portal, the system updates the Shipment Date
field value on the Shipment Batch page in Business Central accordingly.
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2402.6.0.0
Release Note • 6/11/2024 • 1 min read

Resolved issues
The following issues have been resolved in this release.

ID Description

212290
The Whse. Available to Pack FactBox displays all the items associated with the defined warehouse
document number rather than fetching entries associated with the defined source doucment on the
Pack Scanning page.

212292
An error occurs when attempting to scan multiple orders or create packages for multiple orders on the
Pack Scanning page.
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2402.5.0.0
Release Note • 6/10/2024 • 1 min read

Enhancements/Modifications
With this release of the Aptean Pack and Ship extension, the system inherits the UOM for Scale Company Unit of
Measure field value in the Scale Unit of Measure Code
field on the Pack Scanning page. This enhancement enables the Get Weight action functionality to calculate weight
based on the specified company warehouse location and relevant scale UOM on the Pack Scanning
page. This update addresses the issue reported in the bug ID #211996.

UI/UX changes
The UOM for Scale Company Unit of Measure field is added to the General FastTab of the Ship Setup page.

Resolved issues
The following issues have been resolved in this release.

ID Description

211991
The cursor incorrectly moves to the lines instead of remaining in the Item/UPC/Package field on the
Pack Scanning page, when the Batch Pack and Prompt for Missing Carton toggles on the Pack
Scanning and Ship Setup pages respectively, are turned on.

211996
The system inherits the Scale Unit of Measure Code field value on the Pack Scanning page from the
defined Unit of Measure Code field value on the Package Contents FastTab of the associated Package
page.
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2402.4.0.0
Release Note • 6/6/2024 • 1 min read

Enhancements/Modifications
With this release, you can use the Aptean Scale Integration extension in conjunction with the Aptean Pack and Ship
extension to:

View and manually change the scale code configured for the defined warehouse location on the Pack Scanning
page. This value is inherited from the Location Scale Integration Setup page.

Execute the Get Weight action on the Pack Scanning page to generate the calculated weight for the defined
company warehouse location using the scale UOM in the Weight field.

UI/UX changes
The Scale Code field has been added to the Lines FastTab of the Pack Scanning page.
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2402.3.0.0
Release Note • 5/21/2024 • 1 min read

Enhancements/Modifications
With this release of the Aptean Pack and Ship extension, deleting packages in Business Central will trigger an
automatic void shipment, resulting in the deletion of the corresponding shipment in the Aptean Ship portal.

Resolved issues
The following issues have been resolved in this release.

ID Description

201504

An error occurs when processing sales orders via the Batch Post Sales Orders page when the Invoice
toggle is turned on.

The system displays a validation pop-up message after each shipment process, reducing the efficiency
of the batch job.

An error occurs when posting sales orders via the shipping batch.
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2402.2.0.0
Release Note • 4/10/2024 • 1 min read

Resolved issues
The following issue has been resolved in this release.

ID Description

162625
An error occurs on the Pack Scanning page when creating packages with multiple items from multiple
shipments by entering either the item number or the cross reference number in the Item/UPC/Package
field.
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2402.1.0.0
Release Note • 4/3/2024 • 1 min read

Resolved issues
The following issue has been resolved in this release:

ID Description

187411
The Residential Package toggle on the Shipping Batch page is not automatically turned on even when
the Residential checkbox on the associated Shipping Agent Service is selected.
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2402.0.0.0
Release Note • 3/27/2024 • 1 min read

Features
With this release of the Aptean Pack and Ship extension, you can

Assign the sender address from the selected location card. The name of the company and their corresponding
sender addresses are set up in the Ship Portal. On the Location Card page, on the Aptean Pack and Ship
FastTab, in the Aptean Pack and Ship Sender ID field, the required company can be selected from the available
list. If the field is left blank, the address of the company set as default in the Ship Portal will get inherited.

Post the Shipping Batch associated with a sales order directly from the Sales Orders list page by executing the
Post Batch action.

Enhancements/Modifications
The notification message that appears when an action is carried out without a license key, invalid license key, or with
an expired license key on the Ship Setup page has been curated.

UI/UX changes
The following UI/UX changes have been made in this release:

The notification message indicating either the absence of a license key, an invalid license key, or an expired
license key has been refined.

The Aptean Pack and Ship FastTab has been added to the Location Card page.
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2401.0.0.0
Release Note • 2/21/2024 • 2 min read

Features
Improved packaging support for LTL Carriers via the Integrated LTL Carrier checkbox on the shipping agent. To
know more, see Aptean ship carrier integration

The Service Options information provided on the Carrier Detail Card page will have the following priority order:

1. Ship-to Address

2. Customer Card

3. Shipping Agents

These values, in terms of priority level, will be updated on the Carrier Detail Card page of the associated sales order.
If no values are defined in the Service Options section on the Carrier Detail Card of the associated Ship-to
Address/Customer Card/Shipping Agents, the values from the sales order page are considered. While creating a
Package, these values are updated in the Package Carrier Detail.

Note

If the values are modified on the sales order page after a package is created, you will receive a confirmation
message. However, these values will not be changed in the Package if these values are changed in the Sales
Header Carrier Details once a package is created. You can modify the values only on the first package if
multiple packages are available.

You can now define the Shipping Carrier NMFC Code for package from sales order. This value is inherited from
the Shipping Carrier NMFC Code field on the Item Card page. If the field is blank, it is inherited from the
Shipping Carrier NMFC Code field on the Ship Setup page. This updates the NMFC Category Code, NMFC
Category subcode, and0 NMFC Class fields on the Ship Portal.

UI/UX Changes
The following UI/UX changes have been added to this release:

The Shipping Carrier NMFC code list page is added.

The Shipping Agent Details action on the Packages page has been renamed Carrier Details.

The Service Options section has been added to the Carrier Detail Card page.
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The Shipping Carrier NMFC Code field is added to the Ship FastTab of the Item Card page.

The Shipping Carrier NMFC Code field is added to the International FastTab of the Ship Setup page.

The Integrated LTL Carrier checkbox is added to the Shipping Agents page.

Resolved issues
The following issue has been resolved in this release:

ID Description

153995
The value in the first line of the Qty. To Pack field is copied to other lines on the Sales Packages page
while using the Packaging action from the sales order.
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2302.2.0.0
Release Note • 2/14/2024 • 1 min read

Enhancements/Modifications
With this release of the Aptean Pack and Ship extension, the Order Status action on the Role Center page has been
deprecated to align with the BC 24 upgrade.

UI/UX changes
The Order Status action on the Role Center page has been deprecated.
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2302.1.0.0
Release Note • 1/18/2024 • 1 min read

Resolved issues
The following issue has been resolved in this release:

ID Description

169151
The Qty. Packed field on the PACK SCANNING page is not calculated based on the value in the Units
per Parcel field on the PACKING RULES page.
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2302.0.0.0
Release Note • 11/3/2023 • 1 min read

Features
With this release of the Aptean Pack and Ship extension, you can

Set up the Shipping Agent Code and Shipping Agent Service Code values directly on the Warehouse Shipment
card page. To know more see, Shipping Batch.

Perform the Shipping Batch and Add Freight and Handling actions on the released sales order page without the
approval through workflow process.

Resolved issues
The following issues have been resolved in this release:

ID Description

152024

The Lot No. field value is not populated on the Package page.

While creating the package, when multiple lots are available and if the Qty. to Pack is less than the
Outstanding Qty. to Pick, the Item Tracking Dialog box does not appear to enter the preferred lot.
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2301.1.0.0
Release Note • 10/18/2023 • 1 min read

Resolved issues
The following issues have been resolved in this release:

ID Description

148047
The Line Amount Excl. Tax field values on the Sales Order lines are not updated correctly for Freight
and Handling.

147071 The Tracking No. field value is not populated on the Packaging Details lines for LTL Shipments.

151549 After posting the shipment, the Tracking No. field value is not updated on the Sales Order page.

148043 The addition of an integration event for a customer in BC18 does not get updated to all versions.
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2.12.117494.0
Release Note • 9/20/2023 • 1 min read

Features
With this release of the Aptean Pack and Ship extension:

The Package Tracking No. field on the Sales Order page is automatically updated when the Ship action is
executed from the Shipping Batch page.

You can only use a No. Series consisting exclusively of numbers in the Package Nos. field on the Ship Setup
page. Using an alphanumeric No. Series will cause an error.

You can pick the Shipping Agent Code and Shipping Agent Service Code directly from the Shipping Batch
page.

Resolved Issues
The following issues are resolved in this release:

ID Description

135646
When posting Packages, the packing list does not print even when the Auto Print Packing List toggle is
turned on in the Ship Setup.

136892
An error occurs on the Sales Packaging page if the value in the Outstanding Qty. to Pack field is set to
a decimal value.

139627
On the Pack Scanning page, the cursor in the Item/UPC/Package field stops blinking after an item is
added.

139866
If a sales order has multiple shipping batches that have been shipped but not posted, posting one of
the shipping batches causes an error.
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2.11.100815.0
Release Note • 5/31/2023 • 1 min read

Enhancements
The Aptean Pack and Ship extension is updated to seamlessly work with the Microsoft Dynamics 365 Business
Central 2022 Release Wave 1 platform, ensuring compatibility and smooth functionality.

To know more about the features in this release, see:

Features for Dynamics 365 Business Central, 2022 Release Wave 1

Features for Dynamics 365 Business Central, 2021 Release Wave 2

https://learn.microsoft.com/en-us/dynamics365-release-plan/2022wave1/smb/dynamics365-business-central/planned-features
https://learn.microsoft.com/en-us/dynamics365-release-plan/2021wave2/smb/dynamics365-business-central/planned-features
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2.10.83682.0
Release Note • 4/3/2023 • 1 min read

Features
With this release of the Aptean Pack and Ship extension, you can:

Ship the sales order on the Shipping Batch page with a shipping agent code. The new Integrated Carrier
checkbox must be selected for the specified shipping agent code on the Shipping Agents page. For more
information, see Shipping Batch.

Use Pack and Ship and Pack, Ship and Post functions on the Sales Order page only if the shipping agent code is
specified. For more information, see Posting Shipments.



Aptean Pack and Ship

Page 49 of 159

2.9.83035.0
Release Note • 4/3/2023 • 1 min read

Modifications
The Item Cross Reference table has been renamed to Item Reference in accordance with the changes made in
Business Central version 22.
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2.8.67023.0
Release Note • 4/3/2023 • 1 min read

Resolved Issues
The following issue is resolved in this release:

ID Description

70311
An error occurs while selecting the Customer Name on a new Sales Order. Additionally, the Customer
No. is not filled in correctly when creating a New Document from the Customers list.
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2.7.55516.0
Release Note • 4/3/2023 • 1 min read

Enhancements / Modifications
Minor technical changes were made to keep our apps in line with updated coding guidelines for Business Central.
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2.6.48324.0
Release Note • 4/3/2023 • 1 min read

Features

Aptean Pack and Ship Setup

On the Aptean Pack and Ship Setup page, a new Environment field is added on the General FastTab. You can use
this field to choose the type of environment that you want to use.

Note

You must specify the tenant and location in the respective fields when changing the environment type.

Added Actions

On the Ship Setup page, the following actions are added under the Related menu:

Shipping Billing Rules

Shipping Carrier Service Level

Shipping Agents

You can navigate to the respective pages using these action buttons.
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2.6.47119.0
Release Note • 6/4/2023 • 2 min read

Features
This release introduces integration to the Aptean Pack and Ship solution, which now performs the pick, pack, ship,
and all EDI features supported by Aptean.

Note

The content related to all other shipping integrations is moved under legacy section and will no longer get
updates, enhancements, or support.

Renamed Actions and Fields

On the Extension Management page, the extension has been renamed as Aptean Pack and Ship.

On the User Card page, the Pack-n-Ship user permission set has been renamed as Aptean Pack and Ship.

The Pack-n-Ship Setup page has been renamed as Ship Setup.

The Pack-n-Ship Cue Setup page has been renamed as Ship Cue Setup.

On the Customer Card and Item Card page, the Pack-n-Ship FastTab has been renamed as Ship.

The Pack-n-Ship action has been renamed as Ship on the following pages:

Sales Orders

Sales Order

Inventory Pick

Posted Inventory Picks

Edit – Inventory Pick Packaging

Warehouse Shipment

Posted Warehouse Shipment

Transfer Order

Transfer Packaging

Posted Transfer Shipment

The Pack-n-Ship caption has been renamed as Ship on the following reports:

Pick List

Put-away List

https://erpdocs.apteancloud.com/bc/docs/aptean-ship/legacy/
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Shipmt. Picking List

Added Actions

On the Shipping Batch page, a new Print All Documents action is added under the Print menu that you can use
to print all the documents.

Note

This Print All Documents action is added only for Aptean Ship.

On the Shipping Batch page, a new Carrier Labels action is added under the Print menu that you can use to
print the carrier labels.

On the Shipping Batch page, Package Label and Custom Invoice actions are newly added under the Print menu
that you can use to print the package labels and custom invoices.

Note

The Package Label and Custom Invoice actions are added only for EasyPost.

On the Shipping Batch page, the Edit Shipment, View Shipment, and Update Shipping Batch actions are newly
added under the Related menu that you can use to edit shipment, view shipment, and update the shipping
batch.

On the Shipping Carrier Service Level page, a newGet Carriers action is added to the action bar that you can
use to view the carrier details.

Rate Shopping

On the Ship Setup page, a new ApteanShip rate shopping is added in the Rate Shopping API field on the Carrier
Integration FastTab. You can use this to rate shop orders and packages.

Shipping Batch

You can get the shipping batch details by packing and shipping the sales order. For more information, see Shipping
Batch.
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2.3.212725.0
Release Note • 6/4/2023 • 1 min read

Aptean Pack and Ship was updated to work with the Microsoft Dynamics 365 Business Central 2021 Release Wave 1
platform.

To know more about the features in this release, see:

Features for Dynamics 365 Business Central, 2021 Release Wave 1

Features for Dynamics 365 Business Central, 2020 Release Wave 2

Features

Label Printer Settings

You can assign any combination of workstation machine names, user ids, and label formats. For more information,
see Label Printer Settings.

https://docs.microsoft.com/en-us/dynamics365-release-plan/2021wave1/smb/dynamics365-business-central/planned-features
https://docs.microsoft.com/en-us/dynamics365-release-plan/2020wave2/smb/dynamics365-business-central/planned-features
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2.2.210996.0
Release Note • 6/4/2023 • 2 min read

Features

Carrier Integration through a multi-carrier

New tables for Shipping Career and Shipping Career Service Level to store all possible Shipping Careers and
Shipping Career Services from EasyPost are added. For more information, see Shipping Carrier.

Two new fields Shipping Account No. and Ship-from Account No. in the transactional tables, are added. This
should now flow from Customer to Sales Header and Sales Header to Shipping Batch. For more information, see
Ship-from Addresses.

Default Carrier Service field is added to map EasyPost Shipping Carrier with Shipping Agent. For more
information, see Shipping Agents.

Carrier Packaging Type field is added on the Package Header table. Code added to flow Shipping Agent
Packaging Type from Shipping Carrier Service Level or Shipping Carrier. For more information, see Shipping
Agents.

Shipping Carrier Serv. Level field is added to map EasyPost Shipping Carrier Service Level with Shipping Agent
Service of Business Central. For more information, see Shipping Agent Services.

A new table under Carrier Details to set up and store reference-related information is added that is shared to
EasyPost API. For more information, see Default Service Details.

A new table Rate Shopping Buffer for Rate Shopping functionality is added to create an order. You can show
rates fetched by populating this table by enabling the user to shop from available rates. For more information,
see Freights Assignment.

A new field Get Rate action is added in the Sales Order Add Freight page. Now it can create orders with
EasyPost, fetch rates and show on another page to enable users to select from them. For more information, see
Freights Assignment.

Procedure is added to create an EasyPost Web account and obtain the API Key. For more information, see Setup:
Preliminary Steps.

You can now pack the order from Shipping Batch. It can then finally be shipped via EasyPost Multi Carrier
Integrator and also you can print the Carrier Label obtained in PNG from Shipping Batch. For more information,
see Shipping.

Warning of upcoming license expiration

On the Ship Setup Page, the following fields are added:
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Expiration Notification (Days) - You can enter the number of days before which you want to get the warning of
license expiration.

Disable Expiration Notification - You can use this toggle button to enable or disable the license expiry
notification.

For more information, see Ship Setup.
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Introduction
Article • 6/4/2023 • 1 min read

Aptean Pack and Ship for Business Central was developed by Aptean to manage the packing and shipping of
parcels, pallets, and other containers from within Business Central. It can be implemented not only in companies
utilizing basic outbound documents such as sales and transfer orders, but also warehouse environments of varying
levels of complexity. All data (such as carton and pallet contents, freight and handling charges, and tracking number
information) is stored within Business Central and is easily accessible to the user. Aptean Pack and Ship is fully
integrated with the UPS, FedEx, and USPS (via Stamps.com) carrier services for shipment processing. In addition, the
solution is compliant with Electronic Data Interchange (EDI) transfers and supports the data structures that are
needed to submit advance shipment notification (ASN) from Business Central. All packaging and shipping processes
are easy-to-use and intuitive to the end user.

The Aptean Pack and Ship add-on can also be deployed in cloud environments utilizing Windows Azure. Please
contact Aptean for the most up to date information about supported versions.
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Overview
Article • 6/4/2023 • 1 min read

Aptean Pack and Ship
Aptean Pack and Ship for Microsoft Dynamics 365 Business Central enables integration between Business Central
and shipping carrier services and is built for packaging parcels and pallets. In addition, the solution is fully EDI
(Electronic Data Interchange) compliant and supports the required data structures needed to submit ASNs
(Advanced Shipment Notifications) from Business Central.

Benefits include:

Pallet and parcel packaging

Optimized packing and shipping processes

Fully integrated with Business Central WMS

UPS, FedEx, DHL, USPS, LTL and 3PL (3rd Party Logistics) integration

Scale interfacing

Full support for EDI ASN data structures

Full support for UCC/EAN Logistics Label printing
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Integrated Shipping
Article • 4/3/2023 • 2 min read

When a common carrier such as UPS, FedEx, or USPS is used to perform shipping activities, it becomes necessary to
transmit data according to that carrier’s requirements and methodology. While a company can take on this
responsibility itself, it may be preferable to utilize shipping software developed by a third party. The advantage to
this method is that the company is no longer responsible for learning and staying up-to-date on the carrier’s
standards. For example, if we use a piece of integrated shipping software to process packages for UPS, and UPS
decides to change the format of their tracking numbers, there is no need for us to make any changes to our
activities, as the new change will be handled through our shipping software.

To that end, Aptean Pack and Ship is fully integrated with Aptean Ship integrated shipping. When this integrated
shipping is deployed alongside Aptean Pack and Ship, shipment information is transmitted from Business Central to
the integrated shipping, which will then assign information such as freight and tracking numbers. This data is then
sent back to Business Central, where it is stored in the program. In addition, all of the processes, including printing
the shipping labels and other required shipping documents are handled directly in Business Central.

Note

The content related to all other shipping integrations is moved under legacy section and will no longer get
updates, enhancements, or support.

https://erpdocs.apteancloud.com/bc/docs/aptean-ship/legacy/
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Setup: System Requirements
Article • 4/3/2023 • 11 min read

The task of acquiring hardware for a new Business Central on-premise installation is a daunting one, as there is a lot
of pressure to “get it right.” Equipment with insufficient specifications will guarantee poor, sluggish performance,
leading to unhappy users and an unsuccessful software deployment. A list of required specifications is readily
available, but it is important to distinguish between requirements, which represent the bare minimum necessary to
run the solution, and recommendations, which exceed the minimum and allow your software to operate as it was
truly intended.
Microsoft Dynamics 365 Business Central operates on what is called a “three tier architecture,” in which the solution
comprises three components:

Database Tier – the SQL Server database in which data is stored and maintained.

Server Tier – the Business Central Server service that facilitates communication between the Database Tier and
the Client Tier.

Client Tier – the interface through which users access Dynamics 365 Business Central. Business Central uses a
Web client.
The advantages to this three tier architecture are beyond the scope of this document. It is important from a
hardware perspective, however, because one critical decision companies must make when selecting equipment
is whether the SQL Server database and the Business Central Server service can be housed on the same
computer, or require separate hardware. This question can be easily answered by simply determining the
number of users that will be accessing Business Central:

Up to 25 Users – the database and server tiers may share the same computer.

26-75 Users – the database and server tiers should have their own dedicated machines.

76+ Users – please contact Aptean for additional guidance.
Based on the number of Business Central users in your organization, refer to the appropriate section on the
following pages to select hardware that will allow you to get the most out of your Dynamics 365 Business
Central solution.

Note

The recommendations in this document are meant to serve as a general starting point for hardware/software
selection. Your IT personnel/provider should discuss your specific needs and environment with your Business
Central provider prior to making hardware and software purchases.

Up to 25 Users: SQL Server/ Business Central Server
Server Type: Dedicated or Virtual*
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Specification Minimum Recommended

Memory 32 GB 64+ GB

Processor 1x Quad Core Processor 2-16 CPU Cores

Disks -

Disks - SAS/SSD Drives, configured with the following RAID setup:
Operating System - RAID1
RPM – Minimum of 15K
T-Log – RAID1 (RAID10 Preferred)
Database – RAID10
Backup Disk – RAID1 or externally attached USB 3.0

Optional RAID:
• RAID 1 – TempDB/Master, etc.

Operating System: Microsoft Windows Server 2016 Standard

SQL Versions: Microsoft SQL Server 2017 Express, Standard, or Enterprise

SQL Server Express should only be deployed for non-production use such as test or development environments.
It is unsuitable for use as a live environment’s production server.

Business Central Server
25-75 Users

Server Type: Dedicated or Virtual*

Specification Minimum Recommended

Memory 16 GB 32+ GB

Processor 1x Quad Core Processor 2-16 CPU Cores

Disks -
SAS/SSD Drives, configured with the following RAID setup:
• Operating System - RAID1

Operating System: Microsoft Windows Server 2016 Standard

SQL Server
Server Type: Dedicated or Virtual*
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Specification Minimum Recommended

Memory 32 GB 64+ GB

Processor 1x Quad Core Processor 2-16 CPU Cores

Disks -

SAS/SSD Drives, configured with the following RAID setup:
• Operating System - RAID1
• RPM – Minimum of 15K•T-Log – RAID1 (RAID10 Preferred)
• Database – RAID10
• Backup Disk – RAID1 or externally attached USB 3.0

Optional RAID:
• RAID 1 – TempDB/Master, etc.

Operating System: Microsoft Windows Server 2016 Standard

SQL Versions: Microsoft SQL Server 2017 Express, Standard, or Enterprise

We highly recommend Business Central and related SQL virtual machines run on the same host/hypervisor, as it
has been observed that the placement of virtual machines on separate hosts has resulted in adverse effects on
Business Central’s performance.
SQL Server Express should only be deployed for non-production use such as test or development environments.
It is unsuitable for use as a live environment’s production server.

Note

Client workstations are used for other activities beyond accessing Business Central, it is difficult to provide
hardware recommendations; specifications that allow Business Central to perform as desired may not be
sufficient for other applications that will be used on the same workstation. However, when making purchasing
decisions, it should be noted that Business Central performs at a high level on workstations with Core i5 CPUs.
While other considerations may necessitate the purchase of workstations with Core i7 CPUs, this is not a
requirement for Business Central.

Network Recommendations
To ensure that data is transmitted to and from Business Central at optimal speeds, your network should meet the
following criteria:

Internet Connection Latency: < 100 ms

User Bandwidth (Download): > 2 Mbps

User Bandwidth (Upload): > 0.5 Mbps
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Configuring the Business Central Server
To ensure optimal performance, there are a number of configuration activities that should be performed on the
Business Central server. As noted in the previous section, your Business Central Server may or may not be housed on
the same machine as your SQL Server database. If each tier has its own dedicated piece of hardware, it is only
necessary to perform these configuration procedures on the Business Central Server’s machine.
There are two features that must be enabled on the Business Central Server:

Windows Search Service – one of the components of the Business Central Server service tier is a Help Server that
allows users to search and navigate among Business Central’s online help files. To allow for search capabilities, it
is necessary to enable a platform called the Microsoft Windows Search service.

.NET Framework 4.7 – the software framework on which Business Central is run.
The configuration procedures below apply to Windows Server 2016, which is the recommended operating
system. If you are using an operating system other than Windows Server 2016, the manner in which these
components are enabled may differ.

To Enable Windows Search Service:

1. Start the Server Manager tool that is included as part of Windows Server.

2. Click Manage, and then click Add Roles and Features.

3. On the Before You Begin page, click Next.

4. On the Installation Type page, select Role-based or Feature-based Installation, and then click Next.

5. On the Server Selection page, select the server or virtual hard disk on which to install Windows Search Service.

6. On the Server Roles page, click Next.

7. On the Features page, select Windows Search Service, and then click Next.

8. On the Confirmation page, verify that Windows Search Service is listed, and then click Install.

To Enable .NET Framework 4.7:

1. Start the Server Manager tool that is included as part of Windows Server.

2. Click Manage, and then click Add Roles and Features.

3. On the Before You Begin page, click Next.

4. On the Installation Type page, select Role-based or Feature-based Installation, and then click Next.

5. On the Server Selection page, select the server or virtual hard disk on which to install .NET Framework 4.7.

6. On the Server Roles page, click Next.

7. On the Features page, select .NET Framework 4.7 Features, and then click Next.

8. On the Confirmation page, a warning will be displayed asking Do you need to specify an alternate source path?
If the target computer does not have access to Windows Update, click the Specify an alternate source path link
to specify the path to the \sources\sxs folder on the installation media and then click OK. After you have
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specified the alternate source, or if the target computer has access to Windows Update, click the X next to the
warning, and then click Install.
If you are using Server Manager in Windows Server to add a role or feature to a remote server, the remote
server’s computer account (DOMAIN\ComputerName$) requires access to the alternate source file path because
the deployment operation runs in the SYSTEM context on the target server.

Prerequisites to Working with Business Central
Although certain activities, such as hardware setup and software installation, are readily apparent, there are other
procedures that should be performed if you wish to get the most out of your Business Central solution. These steps
are highlighted in the following sections.

Note

These steps are dependent on the presence of SQL Server, and cannot be performed until after SQL Server had
been installed.

Install SQL Reporting Services
SQL Server Reporting Services (SSRS) is an extension to SQL Server that allows you to create and deploy reports
from SQL Server. These reports are then connected to a SQL database, such as a Business Central database.
Although it is not necessary for SQL Server Reporting Services to be present on the same machine as SQL Server
itself, oftentimes it is convenient to do so.
This link provides a comprehensive description of how to install SQL Reporting Services. Although the initial sections
of this page contain useful information, those interested in the setup procedures can skip to the “Install Native
Mode with the SQL Server Installation Wizard” section.

Install SQL Server Data Tools
If you wish to perform more extensive SQL report development and deployment activities, as well as batch deploy
SSRS reports, you must install SQL Server Data Tools. These tools should be installed alongside your TEST
environment, as opposed to the LIVE environment. Although it is not necessary, it is best practice to develop and
test new reports within a testing environment, then move these reports to the live environment once testing
requirements have been satisfied. It is not recommended that report development and testing be performed directly
within a live environment.
This link provides a comprehensive description of how to install SQL Server Data Tools.
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Set Up a User as a System Administrator
In order to properly assist you with configuring, testing, and troubleshooting your Business Central solution, it will
be necessary for you to set up the account on your domain’s active directory, and provide that account with system
administrator access to both your TEST and LIVE Business Central environments. Please consult with your IT
personnel (either internal or external) as to how to best set up the user in this manner.
It will also be necessary to provide the account with sysadmin access to SQL Server. This link provides a
comprehensive description of how to enable this role for users.

Obtain a Certificate for the Universal App
The Business Central Universal App comprises the Business Central Tablet client and Business Central Phone client,
which make it possible for users to access Business Central data via a tablet or smartphone. This app can only run on
an HTTPS protocol, and in order to enable support for HTTPS, you must implement security certificates. Complete
instructions on performing this activity should be available from your certificate provider. It is recommended that
you secure the data that is transmitted to and from your users’ devices by enabling Secure Sockets Layer (SSL) on
the connection to the Business Central Universal App.
This link provides additional information on how to use HTTPS and implement security certificates.

Setting Up a Test Database
In addition to your Production (aka Live) database, in which your users perform their daily work activities, it is also
necessary to set up a Test database for the purpose of testing updates, enhancements, and new business processes.
Once a particular update or procedure passes testing, it can be deployed within the Production environment. The
Test database also serves as a training environment for new users.

Regardless of whether your Business Central server is located at your site or a hosting facility, your Test database
should exist on a separate server from your Production database. Only under extenuating circumstances should
these two environments reside on the same server. The rationale behind keeping them separate is to ensure that
activities performed in the Test database (such as backups or the running of lengthy batch jobs) do not have a
negative effect on performance in the Production database. Segmenting the two databases also ensures that all
testing activity can be performed in the Test environment without impacting the integrity of the Production
environment.
In the case of the Test database, the minimum hardware requirements are acceptable; it is not necessary to acquire
hardware that meets the recommendations in this document. If desired, a completely virtualized environment is
sufficient.

It is recommended that the Test database be periodically refreshed with data from the Production database in order
to maintain a testing/training environment that accurately reflects relatively recent business activities.
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Setup: Preliminary Steps
Article • 4/3/2023 • 1 min read

Before setting up the Aptean Pack and Ship module within Business Central, the following activities must be
completed:

Business Central Subscription: If you want a subscription to Aptean Pack and Ship, please contact Aptean
Support.

Integrated Shipping: If you intend to add electronic rating and shipping to your Aptean Pack and Ship solution,
please contact Aptean Support.

Aptean Ship Web Setup

To integrate with ApteanShip Web platform, see Configure Aptean Pack and Ship.

Note

The content related to all other shipping integrations is moved under legacy section and will no longer get
updates, enhancements, or support.

https://lp.aptean.com/LP-Food-and-Beverage-AppSource
https://lp.aptean.com/LP-Food-and-Beverage-AppSource
https://lp.aptean.com/LP-Food-and-Beverage-AppSource
https://erpdocs.apteancloud.com/bc/docs/aptean-ship/legacy/
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Setup: Security
Article • 4/3/2023 • 2 min read

If shipping activities will be processed by a user, they must have permission to access the appropriate objects.

Note

These permissions must extend to users who may not work directly with Aptean Pack and Ship, but do process
documents that are designated as being part of an Aptean Pack and Ship process. For example, if an Customer
need specific setup relating to Aptean Pack and Ship, the user will need permission to update these fields on
the Customer card.

The following Aptean Pack and Ship permission sets have been developed and may be assigned to users:

Permission NAV Code Description Includes

Ship Process
BC-PACK-
SHIP

Allows the user to create and
record the shipment of packages
using Aptean Pack and Ship
functionality. These basic Aptean
Pack and Ship permissions do not
allow any substantial setup
capabilities on the part of the user.

Ship Customer Setup
BC-PACK-
SHIP-CUST

Allows the user to make entries in
in the customer-based setup
tables that are required to
properly configure the Aptean
Pack and Ship solution.

Does not include the processing
permissions defined within
theAptean Pack and Ship Process
permissions set.

Ship Item Setup
BC-PACK-
SHIP-ITEM

Allows the user to make entries in
the item-based setup tables that
are required to properly configure
the Aptean Pack and Ship solution.

Does not include the processing
permissions defined within the
Aptean Pack and Ship Process
permissions set.

Ship Setup
BC-PACK-
SHIP-SETUP

Allows the user to make entries in
the setup tables that are required
to properly configure the Aptean
Pack and Ship solution.

Includes all permissions defined
within the Aptean Pack and Ship
Customer Setup and Aptean Pack
and Ship Item Setup permissions
sets. Does not include the
processing permissions defined
within the Aptean Pack and Ship
Process permissions set.
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These permission sets are included as part of Aptean Pack and Ship RapidStart Package. You can get the RapidStart
configuration package by contacting Aptean Support.

https://lp.aptean.com/LP-Food-and-Beverage-AppSource
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Setup: Business Central
Article • 4/3/2023 • 5 min read

Once the preliminary setup steps have been completed, you must configure your Aptean Pack and Ship solution in
Business Central. All setup activity can be performed from the Ship Setup menu.

You can set up Default details for UPS, FedEx, and USPS. These values are defined from the Ship Setup window by
clicking the Navigate tab and selecting one of the options in the General group.

For example,

Default UPS Detail

Fill in the fields as follows:
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Notification E-Mail Address: Enter the address of the account from which e-mail notifications of shipments that
will be completed via UPS will be delivered.

Reference Fields: The shipping integration allows for the assignment of up to 3 reference values for each UPS
shipment. If your Aptean Pack and Ship solution will be used in conjunction with the 3rd party shipping
integration, you may define these values. Each reference value has its own field, as well as a corresponding
default reference field. A default reference value can be selected from a list of available options, and include
Sales Order No., External Document No., Your Reference, Posting No., and Package UCC No. When a sales order
is created, the program will automatically assign the relevant piece of information to the corresponding
reference field. For example, if we assigned the sales order number as the default reference 1 value, the program
would automatically assign a sales order’s number as that document’s reference 1 value. Alternatively, an entry
can be made directly in the reference value field. This entry will override any assigned default reference
selections, and automatically be assigned on new sales orders. For example, if we assigned a contact phone
number as the reference 1 value, this phone number would be assigned as the reference 1 value on all sales
orders. It is also possible to leave both fields blank if there is a reference value that will be assigned on an order-
by-order basis. For example, if each sales order has a specific contract number, we may leave one of our
reference values blank, then instruct users to open the UPS Detail Card directly from each sales order and
manually assign this information.

Delivery Confirmation: Select the default delivery confirmation value that will be assigned to shipments using
the service. When a shipping activity is sent to the shipping integration, the shipment record’s delivery
confirmation setting will be populated based on the value on the corresponding record in Business Central.
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Carton Types
Article • 4/3/2023 • 2 min read

If you use a number of standard packages to perform packaging activities, you can set up them as carton type
records in the Carton Types page.

Each carton type you want to set up is entered as a code on a separate line. The standard height, length, and width
measurements of the carton type can then be entered in the corresponding fields. The program will multiply these
three values to obtain the carton’s volume, which is presented in the Cubage field. If a change is made to one of a
carton’s dimensions, its cubage will be automatically updated. It is also possible to manually adjust the calculated
cubage, if desired.

When a carton type code is assigned to a package record, its associated dimension values will be assigned to the
package, as well.
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Business Central: Ship Setup
Article • 12/18/2024 • 19 min read

A number of values must be configured before you can use the Aptean Pack and Ship solution. These settings are
entered in the Ship Setup page, which can be accessed by entering ship setup in the search bar.

General FastTab

Fill in the fields as follows:

App is disabled: To disable Aptean Pack and Ship functions, turn on this toggle.

App Version: This field displays the Aptean Pack and Ship app version.

Local ISO Country Code: Local country code should be entered here.

Tracking No. Mandatory: Turn on this toggle if you want to require the presence of a tracking number on all
shipping batch records prior to posting. If this option is selected and the user attempts to post a shipping batch
that does not have an assigned tracking number, a notification message will inform the user of this missing
value.

Package Weight is Mandatory: Turn on this toggle if you want to require the presence of a weight value on
package records prior to posting. If this option is selected and the user attempts to post the shipment of a
package that does not have an assigned weight, a notification message will inform the user of this missing value.

GS1 Company Prefix: If your organization has obtained its own GS1 company prefix to be included as an
identifier in its barcodes, it must be entered in this field. If your organization does not have its own GS1
company prefix, enter a value of 00000 in this field.

Freight Line Creation: Select the manner in which automatically generated freight lines will be added to sales
orders. You can instruct the program to create either one freight line for every location that appears on a sales
order, or one line for the entire order, regardless of how many locations are present.

Print Invoice on Whse. Ship.: Turn on this toggle to instruct the program to print an invoice along with a
shipping document whenever the user chooses to post and print a warehouse shipment and selects the Ship
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and Invoice option. If this field is left unchecked, choose to post and print a warehouse shipment with the Ship
and Invoice option will result in the printing of only a shipping document.

Always Delete Whse. Shipment after Posting: Turn on this toggle to instruct the program to always delete a
warehouse shipment after it has posted, including transactions in which only a partial shipment is recorded. If
this field is left unchecked, the program will leave warehouse shipments that have been partially shipped
untouched, only deleting these documents when the full quantity of all items has been shipped.

Always Delete Whse. Receipt after Posting: Turn on this toggle to instruct the program to always delete a
warehouse receipt after it has posted, including transactions in which only a partial receipt is recorded. If this
field is left unchecked, the program will leave warehouse receipts that have been partially received untouched,
only deleting these documents when the full quantity of all items has been received.

Pack Scan Option: Controls the behavior after scanning a document into the Pack Scanning screen:
Blank: No action
Pack All: The system will automatically pack all the packages based upon the packing rule. If no packing rule
applies, all items will be packed into 1 box.
Pack All & Ship: The system will automatically pack all the packages based upon the packing rule. The shipment
will automatically be shipped with the carrier.

Weight Measure: Select the appropriate value of Imperial or Metric.

No. of Shipments per Batch: Enter the number of shipments that can be sent via a batch from the warehouse
shipment. The maximum number of shipments can be set to 20.

License FastTab

Fill in the fields as follows:

Dynamics 365 Serial Number: The serial number from the currently installed Dynamics 365 license is displayed
in this field.

License Key: The key for charge BEE subscription.

License Status: Displays the status of the License.

Tenant ID: The License Tenant.

Version: The currently running version of Aptean Pack and Ship is displayed in this field. This value is copied
from the version tags of the currently installed Aptean Pack and Ship objects.
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PrintNode API Key: If using a package scale or label printer, after registering for an account with PrintNode,
enter the supplied API key.

Expiration Notification (Days) – Enter the number of days before the license expiration, from which you want to
get the license expiration notification. It is set as 7 days by default. If the remaining days of license expiration is
equal or less than the number of days entered in this field, then you will get the notification. If you enter number
of days less than the actual days to expire or value as 0, notification will not appear.

Disable Expiration Notification – When the field is enabled, no notifications about the remaining days of license
expiration will appear.

Expiration Notification is made visible to the following list of Role centers :

Business Manager

Accountant

Dispatcher - Customer Service

Sales Order Processor

Project Manager

Sales and Relationship Manager

Administration of users, user groups

Team Member

Numbering FastTab

Fill in the fields as follows:

Package Nos.: Enter a value or use the AssistEdit button to specify the number series that will be used to assign
unique numbers to package records. The number series cannot contain any non-numerical values.

Carton Nos.: Enter or use the AssistButton to specify the number series that will be used to assign unique
numbers to the carton records that are created manually by the user or through the aggregation of multiple
packages into a single package.

Shipping Batch Nos.: Enter or use the AssistButton to specify the number series that will be used to assign
unique numbers to shipping batch records.



Aptean Pack and Ship

Page 76 of 159

Print FastTab

Fill in the fields as follows:

Auto Print Customs Invoice: Turn on this toggle to instruct the program to automatically print the customs
invoice whenever a package record is released on the Pack Scanning page.

Auto Print Carrier Label: Turn on this toggle to instruct the program to automatically print a package label
whenever a package record is released on the Pack Scanning page.

Auto Print Package Label: Turn on this toggle to instruct the program to automatically print a package label
whenever a package record is released on the Pack Scanning page. The label printed will be the system default
label unless a customer specific label has been designated on the Customer card Ship tab.

Auto Print Content List: Turn on this toggle to instruct the program to automatically print a content list
whenever a package record is released on the Pack Scanning page. The content list printed will be the system
default content list unless a customer specific content list has been designated on the Customer card Ship tab.

Auto Print Packing List: Turn on this toggle to instruct the program to automatically print a packing list
whenever a shipping batch is posted. Please note that it is only possible to automatically print packing lists from
shipping batches that were created from warehouse shipments. The program will use the packing list report that
has been assigned to the customer record for which the shipment activity is occurring. If a packing list report has
not been assigned to the customer record, it is not possible to automate this printing process.

Default Print Invoice on Post: Turn on this toggle to instruct the program to automatically place a check mark in
the Print Invoice field on the Post Packages page whenever it is opened from a shipping batch record. Please
note that, if you wish to select this option, you should not place a check mark in the Disable Ship and Invoice
field on the General FastTab.

Default Print Shipment on Post: Turn on this toggle to instruct the program to automatically place a check mark
in the Print Shipment field on the Post Packages page whenever it is opened from a shipping batch record.
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Pack FastTab

Fill in the fields as follows:

Default Ship Date Start Calc.: No longer used.

Default Ship Date End Calc.: No longer used.

Pack and Ship Reserved Only: Turn on this toggle to instruct the program to limit the automatic packaging and
shipping of items from a source document to reserved quantities. For example, if we had a sales line for 6 units
of an item, 2 of which were reserved, and instructed the program to pack and ship directly from the source
document, only 2 of the 6 units would be packaged and shipped. This feature only impacts that automated
processing that takes place when the user selects either the Pack and Ship or Pack, Ship and Post options from a
source document.

Auto Populate Weight: Turn on this toggle to instruct the program to automatically calculate a weight for new
package records. A package’s weight is calculated from the total weights of its contents. If this field is left
unchecked, package weights must be manually entered by the user unless a scale is setup. See Scale and Printer
Setup for more information.

Default Ship and Invoice: Turn on this toggle to instruct the program to default the Selection field on the Post
Packages page to the Ship and Invoice option. If this field is left unchecked, the Selection field on the Post
Packages page will default to the Ship option. Please note that, if you wish to select Ship and Invoice as the
default posting option, you should not place a check mark in the Disable Ship and Invoice field on the General
FastTab.

Default Carton Type: Indicate the carton type that will be assigned by default to new package records. The
default carton type can be Re-Pack or Self Contained.

Default Carton Type Code: If the selection in the Default Carton Type field is Re-pack, enter or use the
AssistButton to specify a carton type code that will be assigned by default to new package records. A default
carton type code cannot be specified if the default carton type is Self-Contained.

Default Packaging Type: Indicate the packaging type that will be assigned by default to new package records.
The default packaging type can be Carton or Case, Pallet or container larger than a carton, Container larger than
a pallet, Undefined container type, or Internally defined for intra-company use.

Pre-Pack (Pack before Pick): Turn on this toggle to enable the program to create package records for items on a
warehouse shipment prior to the picking activities for these items has been posted. If this field is left unchecked,
items must be picked before they can be assigned to package records. Please note that permitting the
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packaging of items prior to picking does not eliminate the picking requirement altogether, as items must still be
picked before the warehouse shipment can be posted.

Prompt for Missing Carton: Turn on this toggle to instruct the program to prompt the user to assign a carton
type to package records before they are closed from the Pack Scanning page. If this feature is enabled,
attempting to close a package that does not have an assigned carton type will result in the program presenting
a list of available carton type codes. The user can select one of these codes to assign it to the package record. It
is also possible to finish the package without assigning a carton type code.

No. of Cartons is Mandatory: Turn on this toggle to ensure that package records must have an assigned
number of cartons before they can be closed from the Pack Scanning page. If this feature is enabled, attempting
to close a package that does not have an assigned number of cartons will result in the program notifying the
user that this information must be recorded.

Disable Pack Release All: Turn on this toggle to disable the Release All feature on the Pack Scanning page. This
may be useful when multiple users are entering package records, as it will prevent one user inadvertently
releasing packages that are being processed by other users.

Disable Pack Release and Ship: Turn on this toggle to disable the Release and Ship feature on the Pack
Scanning page. This may be useful in environments in which the release and shipment of packages are two
separate, distinct processes that should not be recorded as one activity.

Batch Pack Default: Turn on this toggle to enable the Batch Pack toggle on the Pack Scanning page.

Carrier Integration FastTab

Fill in the fields as follows:

Disable Carrier Integration: Turn on this toggle if you want to disable any existing carrier integration. While
environments in which carrier integration is present will normally wish to have this integration activated, it may
be necessary to temporarily disable it on occasion for troubleshooting activities. Please note that many of the
records contained within Aptean Pack and Ship RapidStart Package are set up to require connectivity with the
3rd Party Shipping Integration. If RapidStart is being utilized to configure Aptean Pack and Ship, but 3rd Party
Shipping Integration will not be used to process shipments, carrier integration should be disabled.

Carrier Integration Test: To enable logging request & response for api calls in a text file, turn on this toggle.
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Display Integration Result: Used in testing to display a message returned from the 3rd Party Shipping
integration.

Rate Shopping API: Choose the 3rd Party Shipping Integration you will be using to rate shop orders and
packages.

Note

ShipRush integration does not provide the ability to rate shop.

Carrier Service Level Rule: If a shipment does not have a Shipping Agent Service chosen, the system will default
to the lowest rate or fastest delivery time.

Update Ship-to Address: Turn on this toggle if you would like the Ship-to Address to be updated with the
corrected address returned from the carrier.

International FastTab

Fill in the field as follows:

Customs Content Type: Enter the type of customs content.

Customs Content Desc.: Enter the description of goods.
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Configure Aptean Pack and Ship
Article • 12/18/2024 • 3 min read

To integrate your Business Central solution with Aptean Pack and Ship:

1. Choose the Search icon , enter Ship Setup, and choose the related link.
The Ship Setup page opens.

2. On the Carrier Integration FastTab, choose ApteanShip in the Rate Shopping API field.

3. On the action bar, choose Ship API Setup.
The Aptean Pack and Ship Setup page opens.

4. In the Environment field, select the type of environment that you want to use.

5. Enter the user name, password, and tenant ID in the respective fields.

6. In the Charge Type field, select the charge type that you want to apply.

7. In the Location field, enter the location from where you want to access your credentials.

8. Turn on the Print on Shipment toggle if you want to print the shipping document automatically.

9. In the Request Timeout in Seconds field, enter the time in seconds for the request timeout. The maximum time
value can be set to 300 seconds.

10. Turn on the Writeback To Source toggle to receive any additional information from the API. However, it is
recommended to turn off this toggle to improve the performance. This toggle is hidden by default but can be
made visible through personalization.

Note

On the Aptean Pack and Ship User Profile page, you can enter the user name, password, and location that
you want in the printed document.

11. On the action bar, choose Create Company.
The new company is created.
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Assisted Setup
Article • 4/3/2023 • 2 min read

To integrate your Business Central solution with Aptean Pack and Ship using Assisted Setup:

1. Choose the Search icon , enter assisted setup, and then choose the related link.

2. The Assisted Setup page opens.

3. Choose Set up your Aptean Pack and Ship Credential.

4. Enter the user name, password, tenant ID, and API Base URL in the respective fields.

5. In the Charge Type field, select the charge type that you want to apply.

6. Choose Finish.
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Default Service Details
Article • 9/3/2024 • 3 min read

It is possible to define default detail settings for the common carriers that perform shipping activities for an
organization. This can expedite and streamline the shipping process, as shipping requests that are sent to carriers
will have these default values assigned automatically by the program.

When a new sales order is created, the program will assign service details from the relevant service. For example, if
we create a sales order with an assigned shipping agent code of UPS, the default UPS details will be assigned to the
document. Defaulted values can always be modified on a document-by-document basis.

In addition to these global defaults, it is also possible to define default service details for individual customer
records. If a sales order is created for a customer record for which default service details have been defined, the
customer-specific values will be used in lieu of the global ones.

To setup and store reference related information shared to EasyPost API and ApteanShip, a new table under Carrier
Details is added.

Carrier Details can be configured at multiple places:

Ship Setup page

Shipping Agents page

Shipping Carrier Service Level page

Sales Order page

You can choose the Item No. option in the Default Reference 1, Default Reference 2, and Default Reference 3 fields.
Once the sales order is packed and shipped, the system groups all item numbers from the associated sales order
lines into the relevant Reference 1, Reference 2, or Reference 3 field. For example, if a sales order includes items
0011, 0012, and 0013, the reference field will display 0011, 0012, 0013.
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Default Billing Rules
Article • 4/3/2023 • 12 min read

It is possible to define billing rules for various charges that are incurred as part of the shipping process. These rules
can be assigned to different types of record, such shipping agent or customer. When a shipment is processed, the
program will determine if any billing rules are associated to the activity, and, if there are, calculate charges based on
their setup.

Default billing rules are set up on the Shipping Billing Rules page. This page can be accessed in a number of
different ways:

From the Ship Setup menu, click Shipping Billing Rules.

From the Ship Setup page, click the Navigate tab and, in General group, select the Default Billing Rules option.

In addition, this page can be accessed from either the Customer card (by clicking the Navigate tab and, in Customer
group, selecting the Shipping Billing Rules option) or Shipping Agent card (by clicking the Navigate tab and, in
General group, selecting the Default Billing Rules option). Accessing the Shipping Billing Rules page in this manner
will cause the program to automatically filter the page to display billing rules that are specific to the customer or
shipping agent from which it was opened.

Note

If a shipping charge is calculated for a sales order for which no associated billing rules exist, the program will
not be able to create new freight lines on the order. It is recommended that at least one default billing rule
record be set up that can be applied globally to all documents, ensuring that new freight lines can always be
assigned to sales orders.

Each billing rule you want to set up is entered on a separate line. You can also define a billing rule on the Shipping
Billing Rule card, which is accessed by clicking the Home tab and, in the Manage group, selecting the Edit option.
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Fill in the fields as follows:

Type: Select the type of billing rule you will be entering on the shipping billing rule line. The entry in this field
will determine what value can be entered in the No. field that follows. Billing rules can be defined for Shipping
Agents, Shipping Agent Services, and Customers. It is also possible to create a Default billing rule which is not
tied to a particular type of record.

No.: Enter or use the AssistButton to select the specific shipping agent or customer (depending on the entry in
the Type field) for which the billing rule will exist. Because shipping agent services are defined within specific
shipping agents, it is necessary to select a shipping agent in this field when the billing rule is being defined for a
shipping agent service. It is not possible to enter a value in this field if the billing rule is default.

Code: Enter or use the AssistButton to select the specific shipping agent service for which the billing rule will
exist. When the billing rule is being defined for a shipping agent service, the No. field must be used to assign a
shipping agent. Once this has been entered, it is possible to assign one of that shipping agent’s services in this
field. This field is only utilized if the billing rule is for a shipping agent service.

Service Type: Indicate the type of shipping service to which the billing rule applies. A billing rule can be defined
for either a Ground or Air service.

Service Destination: Indicate the service destination to which the billing rule applies. A billing rule can be
defined for Domestic, Canadian, or International shipments.

Default Freight Type: If freight will be included as part of the billing rule, you can select the type of freight that
will be assigned by default to shipments. A freight’s type can be No Charge, Actual, Quoted, or Included.

Freight Charges
A separate group of fields allows for the definition of a freight charge:
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If freight will be included as part of the billing rule, fill in the fields as follows:

Type: Select the type of freight line that will be created when the billing rule is applied to an outbound
shipment. The entry in this field will determine what value can be entered in the No. field that follows. A freight
line can be created for a G/L Account, Item, Resource, or Item Charge record.

No.: Enter or use the AssistButton to select the G/L account, item, resource, or item charge (depending on the
entry in the Type field) that will be assigned to freight lines that are created from the billing rule.

Description: Enter a description of the freight charge. When a freight line is added to an outbound shipment
from the billing rule, its description will be copied from the entry in this field.

Markup Method: Select the method by which the freight charge will be calculated. A freight charge can be
either a specified dollar amount, a calculated percentage of a shipped item’s sales price, or a combination of
both methods.

Markup ($): If the markup method is either Markup ($) or Both, enter the dollar amount that will be entered on a
freight line as the freight charge. For example, if we enter a value of 5.00 in this field, then apply the billing rule
to a sales order, the freight line that is generated from the billing rule will include this $5.00 value.

Markup (%): If the markup method is either Markup (%) or Both, enter the percentage of an outbound
shipment’s sales price that will be entered on a freight line as the freight charge. For example, if we enter a value
of 5.00 in this field, then apply the billing rule to a sales order with a sales price of $200, the freight line that is
generated from the billing rule will include a calculated value of $10.00.

Handling Charges
A separate group of fields allows for the definition of a handling charge:
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If freight will be included as part of the billing rule, fill in the fields as follows:

Type: Select the type of handling line that will be created when the billing rule is applied to an outbound
shipment. The entry in this field will determine what value can be entered in the No. field that follows. A
handling line can be created for a G/L Account, Item, Resource, or Item Charge record.

No.: Enter or use the AssistButton to select the G/L account, item, resource, or item charge (depending on the
entry in the Type field) that will be assigned to handling lines that are created from the billing rule.

Description: Enter a description of the handling charge. When a handling line is added to an outbound
shipment from the billing rule, its description will be copied from the entry in this field.

Handling Charge: Select the method by which the handling charge will be calculated. A handling charge can be
either a specified flat rate, a calculated percentage of a shipped item’s sales price, or a combination of both
methods.

Handling Charge ($): If the handling charge is either Flat Rate or Both, enter the dollar amount that will be
entered on a handling line as the handling charge. For example, if we enter a value of 5.00 in this field, then
apply the billing rule to a sales order, the handling line that is generated from the billing rule will include this
$5.00 value.

Handling Charge (%): If the handling charge is either Percentage or Both, enter the percentage of an outbound
shipment’s sales price that will be entered on a handling line as the handling charge. For example, if we enter a
value of 5.00 in this field, then apply the billing rule to a sales order with a sales price of $200, the handling line
that is generated from the billing rule will include a calculated value of $10.00.

If a freight charge and handling charge are both being set up for a billing rule, you can place a check mark in the
Combine Freight & Handling field to instruct the program to consolidate both charges into a single value. A single
line that represents both values will be added to outbound shipments to which the billing rule is applied. If this field
is left unchecked, separate lines for freight and handling charges will be added to these documents. Please note that
the description of these combined lines will be copied from the billing rule’s freight description.
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Aptean Ship: Carrier Integration
Article • 4/3/2023 • 30 min read

If you are using Aptean Ship for electronic rating, tendering, and labels, there are some records within Business
Central that must be configured for data to be properly transmitted. It is not necessary to perform these setup
activities in environments in which integrated shipping is not being used.

Shipment Methods
The shipment method records that represent the various ways in which shipments can be delivered to a customer

are set up in the Shipment Methods page, which can be accessed by entering shipment methods in the  search
bar and clicking the related link.

Business Central allows for the definition of a standard code and description for each shipment method record.
Besides these values, a number of additional fields are included as part of the Aptean Pack and Ship solution. You
must assign values to these fields if you are using the integrated shipping feature. Fill in the fields as follows:

Handling Charge: No longer used. See Default Billing Rules for instructions on how to add Handling Charges.

Insure: Place a check mark in this field if you want to calculate an insurance rate for any shipments to which the
shipment method has been assigned. Checking this option will set package insurance with this shipping method.
Shipping rates will then include insurance. Refer to the related shipping agent/client for more information.

Payment Type: Select the payment type that corresponds to the shipment method. When a shipment is
exported from Business Central to the integrated shipping, the payment type that has been assigned to the
shipment’s shipment method is used to determine the record’s payment value. Please note that the list of
available payment types encompasses the values that are used by the entire library (UPS, FedEx, and USPS);
some of the payment types may not be applicable to your data transfers.

Shipping Carrier

Added a new table to store all possible Shipping Carriers.
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Shipping Carrier Service Level

Added a new table to store all possible Shipping Carrier Services.

Third Party Shipping Accounts

It may be that the cost of shipping is billed not to the shipper or the recipient, but rather a third party. For example,
if a customer orders a company’s products through a broker, that broker may be responsible for the shipping
charges. When you are assigning a payment type to your shipment method records in Business Central, it is possible
to indicate that third party billing should be used for a particular method.

If you intend to bill some or all of your shipments to thirds parties, it is necessary for you to define these shipping
accounts in Business Central. This setup occurs on the Third Party Shipping Accounts page, which can be accessed

by entering third party shipping accounts in the  search bar and clicking the related link.

Each third party shipping account you want to set up is entered on a separate line. For each account, you must enter
the appropriate account number that has been established for that third party. For example, if you are setting up a
shipping account for UPS shipments that are billed to a third party, you must enter that organization’s UPS account
number.

In addition to the account number, basic information about the third party, such as the name, address, and contact
information, can be entered on each line. If you want to display a third party account’s address as the ship-from
address on shipping documents for shipments to which the third party shipping account is assigned, you can place
a check mark in the Use as Ship-from Address field. When a shipping account for which this feature is enabled is
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assigned to a sales order, the address information from the third party shipping account will be displayed on the
relevant shipment documents.

Ship-from Addresses

In some instances, the address from which a package is shipped may not be presented as the shipping address. An
example of this might be a business relationship in which a retailer or broker processes sales orders from customers,
then submits the orders to the companies that are responsible for supplying the product. Although these companies
will execute the shipments, they will be done so under the retailer’s name.

It is possible to define ship-from addresses in Business Central, and associate them to customer accounts. This setup
occurs on the Third Party Shipping Accounts page, which can be accessed by entering ship-from addresses in the

 search bar and clicking the related link.

The Ship-from Addresses page lists all existing ship-from addresses. A separate ship-from address card exists for
each record. You can open a blank card to create a new ship-from address record by selecting the New option on
the action bar. You can view the card of an existing ship-from address by choosing the appropriate line, then
selecting the Edit option on the action bar.

On each ship-from card, you must identify the combination of customer, shipping location, and shipping agent for
which the ship-from address will be applied. This allows for the assignment of different ship-from address in
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different scenarios. For example, in the screenshot above, a ship-from address has been defined for UPS shipments
from the blue location to customer 20309920. If the ship-from address has an associated account with the entered
shipping agent, it can be defined, as well. The other fields on the Ship-from Address card cover basic address
information.

Note

It is also possible to indicate that third party shipping account records (which are set up so that shipping
charges may be billed to a party other than the shipper or recipient) should appear as ship-from addresses.

When a shipment that is exported from Business Central to Aptean Ship meets the criteria of a ship-from address
record, it will be sent to Aptean Ship instead of the company’s information. Please note that the ship-from address
information is only substituted in the Aptean Ship record, and does not replace any values on the outbound
documents in Business Central. If Aptean Ship is not being utilized, the ship-from address functionality serves no
purpose.

Added two new fields Shipping Account No. and Ship-from Account No. in the transactional tables. This should now
flow from Customer to Sales Header and Sales Header to Shipping Batch.
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Shipping Agents
The shipping agent records that are set up in Business Central to represent the different carriers that perform
shipments are set up from the Shipping Agents page, which can be accessed by entering shipping agents in the

 search bar and clicking the related link.

While Business Central’s standard functionality presents a list of shipping agents, the Aptean Pack and Ship solution
provides a separate card for each record. You can view a shipping agent’s card by choosing the appropriate line,
then clicking the Home tab and, in the Line group, selecting the Card option.

Business Central allows for the definition of a standard code and description, as well as an internet address and
account number, for each shipping agent record. Besides these values, a number of additional fields are included as
part of the Aptean Pack and Ship solution. Fill in the fields as follows:

SCAC Code: Enter the Standard Carrier Alpha Code that is used to identify the shipping agent. SCAC codes are
industry standard codes, and typically comprised of four alphabetic characters. This field is for informational
purposes only, and has no impact on shipping activities.

Default fields: A number of default services can be defined for each shipping agent. These values are assigned
on the Defaults FastTab. For every shipping agent, default services can be defined for domestic, residential,
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Canadian, and international shipments. For each of these fields, you can select any of the shipping agent’s
defined shipping agent services that have been classified within the appropriate category. For example, if we
clicked the AssistButton next to the Default International Service field, the program would present us with a list
of the shipping agent’s services that been identified as international. When the shipping agent is assigned to an
outbound shipment, the program will assign the relevant default value based on the shipment’s values.
Continuing with our example, if a shipping method was assigned to an international shipment, the shipment’s
shipping agent service would be copied from the defined default international shipment.

Default Carrier Service: Added this field to map Shipping Carrier with Shipping Agent of Business Central and
should be configured accordingly.

Integrated Carrier: The selection of this checkbox ensures that the corresponding Shipping Agent can be used
for Aptean Ship.

Integrated LTL Carrier: For the LTL Shipping Agent, when this checkbox is selected, and the Packaging Type field
on the Sales Packaging page is set to 1 - Pallet or container larger than a carton, the Carrier Packaging Type
field is updated with Loose Item. This enables you to send the items as loose items instead of boxes, which is a
standard process.

Carrier Packaging Type: Added this new field on Package Header table. Code added to flow Shipping Agent
Packaging Type from Shipping Carrier Service Level or Shipping Carrier. Code added to delete Carrier Detail from
deletion of Package Header.
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Shipping Agent Services
The services that are offered from a particular shipping agent are set up on the Shipping Agent Services page, which
can be accessed from the relevant Shipping Agent card by clicking the Navigate tab and, in the General group,
selecting the Service option.

Business Central allows for the definition of a standard code and description, as well as the assignment of a base
calendar and shipping time, for each shipping agent service record. Besides these values, a number of additional
fields are included as part of the Aptean Pack and Ship solution. You must assign values to these fields if you are
working with Aptean Ship. Fill in the fields as follows:

Service Destination: Indicate the service destination to which the shipping agent service applies. A shipping
agent service can be defined for Domestic, Canadian, or International shipments.

Service Type: Indicate the type of shipping service to which the shipping agent service applies. A shipping agent
service can be defined for either a Ground or Air service.

Residential: Place a check mark here if the shipping agent service includes deliveries to residential addresses.
When a shipment is exported from Business Central to Aptean Ship, the shipment will be designated as
residential in Aptean Ship if the corresponding shipping agent service in Business Central has, as well.

Insure: Place a check mark in this field if you want to calculate an insurance rate for any shipments to which the
shipment method has been assigned. Checking this option will set package insurance with this shipping method.
Shipping rates will then include insurance. Refer to the related shipping agent/client for more information.

Weight Limit: If a shipping agent service imposes a maximum weight on shipments, enter it here. When a
shipment to which the service has been assigned has a weight that exceeds the defined limit, an alternative
service will be used.

Alternative Agent Service Code: If a shipping agent service has a defined weight limit, you must enter or use the
AssistButton to select an alternative shipping agent service that will be assigned to shipments that exceed the
weight limit. For example, if a particular shipping agent service has a defined weight limit of 50 pounds, and a
shipment to which that service was assigned weighs 55 pounds, the alternative service would be automatically
assigned to the shipment in Aptean Ship.
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Shipping Carrier Service Code: If you are using a Shipping Integration, you must select the appropriate code for
the service level.
Related to the setup of shipping agent services is the association of Business Cenral country codes to valid
service destination types. When a sales order is created, the service destination that has been associated to the
order’s country code will determine which shipping agent services are available for the order.

Shipping Carrier Service Level: Added this new field to map Shipping Carrier Service Level with Shipping Agent
Service of Business Central and this should be configured accordingly.

Countries/Regions
Service destinations are assigned to country codes in the Countries/Regions page, which can be accessed by

entering countries/regions in the  search bar and clicking the related link.

Each country code is comprised of a code, name, and some general address format settings. Besides these values, a
Service Destination field is included as part of the Aptean Pack and Ship solution. In this field, you can indicate
whether a country code represents a domestic, Canadian, or international location.
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Master Record Setup
Article • 4/3/2023 • 18 min read

For each customer and item that will be shipped via Aptean Ship, you can set up certain values on the master
record.

Customer Setup

To access a list of customer records, choose the Search icon , enter customers and choose the related link. You
can select the customer record you want to configure for Aptean Pack and Ship, and open the Customer card. A
new field has been added to the Shipping FastTab:

Fill in the field as follows:

Residential: Place a check mark here if the customer has a residential address. A customer’s sales order will or
will not be marked as residential based on the default on the Customer card, although it can be manually
changed on an order-by-order basis, if necessary. When a shipment is exported from Business Central to the 3rd
Party Shipping Integration, the shipment will be designated as residential if the corresponding sales order in
Business Central has, as well.

In addition, a new Ship FastTab has been added to the Customer card:
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Fill in the fields as follows:

Shipping Account No.: If your Aptean Pack and Ship solution will be used in conjunction with the 3rd Party
Shipping Integration, and the customer’s shipments are billed to a third party, enter or use the AssistButton to
select this third party’s account number. When a shipment for the customer is exported from Business Central to
the 3rd Party Shipping Integration, the account number on the record will be populated with this value.

Consolidate Shipments: Place a check mark in this field to instruct the program to consolidate multiple
shipments to the customer into a single activity. When this feature is enabled for a customer, different sales
orders that share the same ship-to address and shipping agent code will be combined as part of one shipping
batch. Please note that this functionality is only applicable in a warehouse environment in which one or more
sales orders can be combined into a single warehouse shipment.

Report ID fields: It is possible to specify the format of certain shipping documents that will be printed for the
customer. Defaults can be specified for the packing list, package content list, and labels that are printed for the
customer’s shipments. Clicking the AssistButton for one of these fields will present a list of Business Central
reports. You can select the report with the desired format to assign it to the custom. If reports are printed for a
customer for whom defaults have not been identified, the program will use reports that have been assigned as
system-wide defaults.

In addition to the fields on the Customer card, there are other Aptean Pack and Ship setup activities that can be
performed for customers:

Default service details can be defined for a specific customer by clicking the Navigate tab, selecting the Carrier
Details option in the Customer Group, and choosing the carrier for which you want to enter service rules.

Default billing rules can be defined for a specific customer by clicking the Navigate tab, and, in the Customer
Group, selecting the Shipping Billing Rules option.

Ship-from addresses can be defined for a specific customer by clicking the Navigate tab, and, in the Customer
Group, selecting the Ship-from Addresses option.

These setup activities can also be performed at a system-wide level, and have been explained earlier in this
document; use the hyperlinks here to view the relevant information. This process of setting up these values for a
specific customer is no different than when they are global settings. When a shipment for a customer with this setup
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is processed, the customer-specific values will take precedence over the system-wide ones. For example, if we define
global billing rules and billing rules specific to a single customer, any shipments for that customer would utilize the
customer-defined billing rules.

Item Setup

To access a list of item records, choose the Search icon , enter customers and choose the related link. You can
select the item record you want to configure for Aptean Pack and Ship and open the Item card. A new Ship FastTab
has been added to the Item Card:

Qty. In Packing Displays the quantity of the item that is currently assigned to package records. You can click the
AssistButton to the right of this field to view a list of these package records.

Master Pack UOM:

Inner Pack UOM:

Shipping Agent Code:

Shipping Agent Service Code:

Item Packing Rules
It is possible to set up packing rules for item records. Packing rules can be defined for different types of shipping
activities, and will impact the way the item is added to packages. This setup is performed in the Packing Rules
window, which can be accessed from the relevant Item card by clicking the Navigate tab and, in the Master Data
group, selecting the Packing Rules option.
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Each packing rule you want to set up is entered on a separate line. This allows for the definition of multiple packing
rules for a single item. For example, it may be that an item can be packed into different types of container, each with
its own unique packing rules.

To define a new packing rule for an item, select a new line in the Packing Rules window and fill in the fields as
follows:

Destination Type: Select the type of destination to which the packing rule will apply. The entry in this field will
determine what value can be entered in the Destination No. field that follows. Packing rules can be defined for
Customers, Vendors, and Locations. This field can be left blank if the packing rule will apply to all packaging
scenarios for the item.

Destination No.: Enter or use the AssistButton to select the specific customer, vendor, or location (depending on
the entry in the Destination Type field) for which the packing rule will exist. It is not possible to enter a value in
this field if the destination type is blank.

Ship-to Code: If the assigned destination is a customer record, enter or use the AssistButton to select the
customer’s ship-to address for which the packing rule will exist. This field is only utilized if a customer record has
been assigned in the Destination No. field. When a customer record has been assigned, this field can still be left
blank if the packing rule will apply to all shipments to the customer, regardless of ship-to address.

Item No.: Enter or use the AssistButton to select the specific item for which the packing rule is being defined.
The value in this field will initially default to the item from which the Packing Rules page was opened, although
it can be manually changed if you wish to specify packing rules for a different item.

Unit of Measure Code: You must enter or use the AssistButton to select the unit of measure code for which the
packing rule will exist. Only units of measure that have been assigned to the item on the Item Units of Measure
page can be entered in this field. If an item can be shipped in multiple units of measure, it possible to create a
separate packing rule for each unit.

Packaging Level: Enter the packaging level for the packing rule. This value represents the level in a packaging
hierarchy to which the packing rule applies. For example, suppose we package an item in individual units, cases
of individual units, and large cases comprised of small cases. In this scenario, we might assign a packaging level
of 1 to the packing rule for the single unit, level 2 for the small case, and level 3 for the large case. The
methodology for identifying and assigning different packaging levels is determined on a company-by-company
basis. This information currently exists for informational purposes only, although it should be noted that
packaging level data is oftentimes contained within system-generated barcodes. If an organization wishes to
include this information, it may wish to design barcode formats that utilize this field to obtain the appropriate
value.

Auto Close Package: If packages will be generated from warehouse shipments, you can indicate how the
program will process packages that are created from the packing rule. The auto close package options are
Always or Confirm. When the number of units contained within packages that are created from the Pack
Scanning page is equal to the value in the packing rule’s Units per Parcel field, the program will either
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automatically close them or ask the user for confirmation of this process. If this field is left blank, packages that
are created from the packing rule will be left open, and must be manually closed by the user.

Units per Parcel: If the packages that are created from the packing rule are configured to auto close, you can
enter the number of item units that will be contained within each package. This allows for the assignment of
multiple items to a single package. If this field is left blank, the program will by default assign 1 unit of the item
to each package created from the packing rule. If a value is not assigned in the Auto Close Package field, the
program will ignore any defined units per parcel. In addition, if the Auto Close Package field is set to Confirm
and the user opts to leave created packages open, the program will ignore any defined units per parcel. In
addition, the number of units per parcel is only applied to packages that are created through a re-pack process;
self-contained packages will ignore this setting.

Carton Type: Indicate the carton type that will be assigned to packages that are created from the packing rule.
The default carton type can be Re-Pack or Self Contained. A packing rule’s defined carton type setting will be
used in lieu of a globally-defined carton type for any package records created from the packing rule.

Carton Type Code: If the selection in the Carton Type field is Re-pack, enter or use the AssistButton to specify a
carton type code that will be assigned by default to packages that are created from the packing rule. A default
carton type code cannot be specified if the default carton type is Self-Contained. A packing rule’s defined carton
type code setting will be used in lieu of a globally-defined carton type code for any package records created
from the packing rule.

Packaging Type: Indicate the packaging type that will be assigned by default to packages that are created from
the packing rule. The default packaging type can be Carton or Case, Pallet or container larger than a carton,
Container larger than a pallet, Undefined container type, or Internally defined for intra-company use. A packing
rule’s defined packaging type setting will be used in lieu of a globally-defined packaging type for any package
records created from the packing rule.

No. of Packages: If the packages that are created from the packing rule are self-contained, you can enter the
number of packages that are required for a single item. This is applicable in situations where an item record
represents multiple pieces or units, each of which is packaged separately. For example, we might set up an item
record for a garbage can. While we stock and sell this item as a single unit, it is in fact comprised of a can and
lid, each of which is packaged separately. In this scenario, we would set up a packing rule for our garbage can
that specified 2 packages per unit. In this way, packing a single unit of the item would result in the creation of 2
package records. It is only possible to define a number of packages per item for packing rules that are self-
contained; re-packed packages will ignore this setting.

If a packing rule specifies that multiple packages are created from a single item, it is possible to define the
characteristics of each package. The activity occurs on the Packing Rule Weight/Dimensions page, which can be
accessed from the Packing Rules page by clicking the Navigate tab and, in the Line group, selecting the
Weight/Dim Distribution option.
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For each package that is required to fully ship the item, a separate line can be entered. You must enter a value in the
Package Entry No. field to identify each line as unique. You can define basic information about each package’s
weight and dimensions. Alternatively, you can enter a carton type code in the Carton/Case Code field. The
dimension values that have been assigned to the selected code will be copied to the relevant fields on the packing
rule weight/dimension line.
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Ship Role Center Cues
Article • 4/3/2023 • 5 min read

The Ship role center presents a number a number of tiles, or "cues."

Both the Order Activities and Warehouse Activities areas present different types of released outbound documents
(sales orders and warehouse shipments, respectively). These outbound activities can be grouped by shipping agent
and shipping agent service. Up to 10 filters can be defined, each with its own role center cue. In this way, a user can
determine the shipping filter that are most critical, and quickly obtain visibility to scheduled shipping activity for
each one. For example, in the screenshot above, we can clearly see that there are 3 sales orders scheduled to be
shipped via UPS’s ground service today.

The shipping filters that will be presented in the Ship role center are entered in the Ship Cue Setup page, which can

be accessed by entering Ship Cue Setup in the  search bar and clicking the related link.

You can define up to 9 separate cue groups. For each cue group, fill in the fields as follows:

Caption: Enter the caption by which the cue group will be identified. The entry in this field will be displayed on
the corresponding tile in the Ship role center.

Shipping Agent Filter No.: Enter or use the AssistButton to select one or more shipping agents that will be
represented by the cue group. Any outbound documents to which a cue group’s defined shipping agents have
been assigned will be included on the corresponding tile in the Ship role center. It is possible to use standard
Business Central filter expressions to include (or exclude) multiple shipping agents within a cue group.

Shipping Agent Serv. Filter: Enter or use the AssistButton to select one or more shipping agent services that will
be represented by the cue group. Only services that have been defined for the shipping agents that are entered
in the Shipping Agent Filter No. field can be assigned here. Any outbound documents to which a cue group’s
defined shipping agent services have been assigned will be included on the corresponding tile in the Ship role
center. It is possible to use standard Business Central filter expressions to include multiple shipping agent
services within a cue group.
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Although there are 10 cue groups listed on the Ship Cue Setup page, you may only configure the first 9. The 10th
cue group is automatically configured to present all outbound activities, with no filters. While the caption can be
changed, any shipping agent and shipping agent service filters that are defined for this cue group will be ignored by
the program.
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Warehouse Employees
Article • 4/3/2023 • 3 min read

If warehousing is being utilized in Business Central solution, users must be tied to the locations in which they are
permitted to record inventory activity. This information is set up in the Warehouse Employees page, which can be
accessed by entering warehouse employees in the search bar.

Each warehouse employee record is at a minimum comprised of a user ID and a location code. For every location in
which a user can perform warehouse activities, a separate warehouse employee record must be created. In the
example above, separate records have been created for the same user.

Besides these standard values, a number of additional fields are included as part of the Aptean Pack and Ship
solution. If Aptean Pack and Ship is being deployed in a warehouse environment, values can be assigned to these
additional fields. Fill in the fields as follows:

Packing/Shipping Station No.: Enter a number identifying the station or area at which the employee performs
packing or shipping activities within the assigned location. It is possible to assign these station numbers to
package records, allowing the user to filter on only these packages that have been assigned to his or her station.
It is not necessary to assign stations to warehouse employees.
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Document Tracking Types
Article • 4/3/2023 • 2 min read

The document tracking type codes that are utilized to set filters on the Document Tracking page are contained in
the Document Tracking Types page, which can be accessed from the Ship Setup menu by clicking Document
Tracking Types.

These document tracking types are included as part of Aptean Pack and Ship RapidStart Package.

Each document tracking type is comprised of a code and a description. Although these values are editable, it is not
recommended that they be modified in any way. The existing document tracking types have all been configured to
represent different types of documents within Business Central and any changes to the records in this table may
disrupt the functionality. If you feel it is necessary to add, modify, or delete the records in this table, please contact
your Business Central partner before doing so.
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Scale and Printer Setup
Article • 4/3/2023 • 7 min read

Aptean Pack and Ship is integrated with scales and label printers using PrintNode. PrintNode is a cloud service
allowing the ability to use an integrated scale and printer within Aptean Pack and Ship.

PrintNode Setup
Complete the following steps to setup an account with PrintNode:

1. Create a PrintNode Account: Enter your Email, First and Last name and create a password.
Go to http://www.printnode.com,

2. Validate Your Email: Once you click on Create, an email will be sent for you to confirm your email account. Click
on the Link to validate your email. Links are also provided for downloading the desktop client, doing a test print
and documentation.

3. Generate the API Key: You can now generate the API Key by clicking on on the API Keys menu at the top of the
page. Enter your password then click Next.

http://www.printnode.com/
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4. API Description: Enter bcPNS for the API Key Description then click Create

5. Ship Setup: Once your API Key has been created, copy the key and paste into the Ship Setup page on the
License FastTab in Business Central.

6. PrintNode Desktop: Run the PrintNode desktop client and take note of the Computer Name and Computer ID.
This will be used when setting up the Shipping/Packing Station.

Note

In the PrintNode settings, the scale needed to be set to Continuous output.

In BC, the weigh scale name is case-sensitive.

1. Packing/Shipping Station Setup: In Business Central, Click New to create a new packing station and assign a
Packing Station No. In the Scale Computer ID, enter or paste the value from the PrintNode desktop from the
previous step.



Aptean Pack and Ship

Page 108 of 159

The Aptean Pack and Ship Role Center
Article • 4/3/2023 • 14 min read

As part of the Aptean Pack and Ship solution, a role center that focuses on the management of packaging and
shipping activities has been developed. This role center has been assigned to the Aptean Pack and Ship profile.

In addition, you can assign the Aptean Pack and Ship role center as the role center to any other profile records by
entering its identification number of 37046552 in the Role Center ID field on the relevant Profile card.

When a user to whom the appropriate profile record has been assigned opensBusiness Central, the Aptean Pack and
Ship role center is displayed.

The various parts of the role center allow the user to perform all necessary Aptean Pack and Ship activities from a
single location.
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The Ribbon
Many of the key pages and reports that are related to the packaging and shipping process can be accessed from the
ribbon at the top of the role center.

The Actions tab lets the user create a number of different sales documents (such as orders and invoices). In addition,
many other pages that are involved with the sales process (including warehouse shipment documents, pick
worksheets, and sales price information) can be opened from here.

The Report tab includes a number of sales/shipping-focused reports.

The Navigation Pane
The Navigation Pane is displayed along the left-hand side of the role center.

It is divided into two sections. The lower portion presents a number of different menu groupings. Selecting one of
these buttons will display the available menu options in the upper portion of the Navigation Pane. If a menu option
has an arrow next to it, there are one or more submenus within the main menu. When you click on the arrow, the
objects contained within the submenu are displayed beneath it. For example, in the screenshot above, the “Picks”
option has been expanded to display submenus for Unassigned, Unassigned Picks, and My Picks.

The following menu groupings are presented in the Aptean Pack and Ship role center’s Navigation Pane:
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Home: presents the Aptean Pack and Ship role center, as well as access to various documents, records, and
journals that are associated with packing and shipping activities.

Reference Data: presents a number of master records (such as customer and items) that are associated with
packing and shipping activities.

Posted Documents: presents posted sales and warehouse shipments.

Registered Documents: presents registered warehouse activities.

Departments: presents a list of all available application areas in Business Central, such as Financial Management,
Sales & Marketing, Purchase, Warehouse, and Manufacturing, as well as Administration, in which all setup
activity can be performed.

The Work Area
The work area is located in the center of the role center, and comprises the greatest amount of space.

The work area will display the contents of whatever menu option has been selected by the user. For example, if one
of the options in the Navigation Pane was a list of sales orders, selecting that option would result in a list of sales
orders being displayed in the work area. From this list, we could choose a sales order record and open it in a
separate window.

When the user views the work area from the Aptean Pack and Ship role center’s home screen, a number of tiles are
displayed. Each tile represents a different type of record. The number of transactions that are currently exist for a
particular record are indicated on the relevant tile. For example, in the screenshot above, we have 3 sales orders that
are scheduled to be shipped via UPS ground service. You can click on a tile to obtain a list of the relevant records.

The tiles on the Aptean Pack and Ship role center’s home screen are grouped together in three separate areas:

Order Activities: present released sales order documents, with each tile representing a different type of shipping
service.

Warehouse Activities: present released warehouse shipments, with each tile representing a different type of
shipping service.
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Activities: present miscellaneous item activities, including picks, put-aways, and internal movements, with each
tile presenting a different type of activity.

While the tiles in the Activities area are predetermined and cannot be modified, the specific shipping services that
comprise the tiles in the Order Activities and Warehouse Activities areas can be determined by the user. Please click
hereto learn more about how to indicate which shipping services will be included on the Aptean Pack and Ship role
center’s tiles.

Charts, Notifications, and My Items
The right-hand side of the role center contains space for a number of objects that are not unique to Aptean Pack
and Ship, but do allow for additional customization on the part of the user.

It is possible to develop charts and add them to role center screens.

By default, a chart that displays existing warehouse shipment lines for each carrier is displayed as part of Aptean
Pack and Ship role center, but it is possible to include additional charts. Different charts are developed according to
different parameters, and may offer varying display options. For example, the Warehouse Shipment Lines by Carrier
chart presents its data according to a number of different visual formats, such as bar and line graphs.

Additional areas on the right-hand side of the Aptean Pack and Ship role center are My Notifications and My Items.
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If a company is utilizing some manner of business notification functionality, the My Notifications area can be
configured to display any notifications that have been sent to the user. The My Notifications area is user-specific,
meaning that a particular user will only see notifications that have been generated specifically for him or her.

The My Items area presents a list of items that a user wishes to highlight and have direct access to from the role
center. A user can quickly open an item record’s Item card by selecting the relevant line, then clicking the Open
button. To add or remove item records from this area, click the Manage List button to access and editable list of the
item records that are displayed in this area.
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Overview of Aptean Pack and Ship Functionality
Article • 4/3/2023 • 2 min read

The Aptean Pack and Ship solution for Business Central is comprised of two major stages, packaging and shipping.

Packaging: the assignment of an outbound document’s contents to one or more packages. Although the
general process is the same, an organization’s level of warehouse complexity can impact the precise manner in
which packaging activities are managed.

Shipping: recording the shipment of packaged goods. This may be performed entirely by the values and settings
within Business Central, or may be processed through the 3rd Party Integration functionality. As with the packing
stage, the type of warehouse environment in which shipping takes places will play a role in how this process
occurs.

In addition to the packing and shipping stages, another key part of the Aptean Pack and Ship solution is the
definition and assignment of freight to outbound shipments. The level of involvement that is required by the user in
this process is predicated on the presence utilizing one of the 3rd Party Integrations. When Aptean Pack and Ship is
utilized in conjunction with a 3rd Party Integration, the assignment of sales freight is automatically performed by this
additional software. If a company chooses to use Aptean Pack and Ship without the 3rd Party Integration, this
activity must be performed manually within Business Central.
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Packaging
Article • 4/3/2023 • 9 min read

A “package” refers to a carton, pallet, or some other sort of container in which items are packed or placed for
shipping purposes. Accordingly, they are created from outbound documents such as sales orders, transfer orders,
and warehouse shipments. The items that exist on these document lines can be assigned to one or more packages.
When you view a package record, you can see the items that are stored within it.

Creating Sales Order Packages
Packages are created for the items that are entered on an outbound sales order. Before this activity can occur,
however, you must release the document by clicking the Home tab and, in the Release group, selecting the Release
option. The Status field on the sales order’s General FastTab will be updated with the new document status.

Once a sales order has been released, you can package its assigned items by selecting Actions > Ship > Packaging.

The Sales Packaging page displays the items that have been assigned to the sales order from which it was opened.
You manage the packaging of these items from here.

Before you can begin to create packages, you must indicate the type of package that will be used. This information
is specified on the Options FastTab.



Aptean Pack and Ship

Page 115 of 159

Fill in the field as follows:

Packaging Type: Select the type of package into which items will be placed. The selected packaging type can be
Carton or Case, Pallet or container larger than a carton, Container larger than a pallet, Undefined container type,
or Internally defined for intra-company use. It is also possible to define a default packaging type for all
packaging activities. If a default exists, this field may be left blank, and the program will automatically use the
assigned default for new packages.

Items
The Items FastTab displays the items that have been entered on the relevant sales order’s lines.

General information about each item (such as the number, description, and unit of measure) is displayed. For each
item, the quantity that is awaiting packaging is displayed in the Qty. Outstanding to Pack field. When you initially
open the Sales Packaging page, the value in this field will be the same as the quantity that was entered on the sales
order. As the item quantities are assigned to packages, the value in this field will decrease. The Avail. Quantity on
Hand field presents the current on hand quantity of the relevant item. Only available items that share the same
location as the sales order are displayed in this field.

The Qty. to Pack field is where you indicate the amount of the item that you wish to assign to a package. You cannot
package a greater quantity than the value in the corresponding Qty. Outstanding to Pack field.

If desired, you can manually enter the quantity of each item you wish to package. However, you can automatically
populate the Qty. to Pack field for all items by selecting Select action on the action menu.
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Available selection options are:

All: The Qty. to Pack field for each item will be automatically populated with the value in the corresponding Qty.
Outstanding to Pack field. Please note that this option does not take availability considerations into account. For
example, if we have an outstanding quantity to pack of 10 units, but only 7 units are available, the program
would still assign a quantity to pack of 10 units.

Available: The Qty. to Pack field for each item will be automatically populated with the value in the
corresponding Qty. Outstanding to Pack field, but will not exceed the amount in the Avail. Quantity on Hand
field. For example, if we have an outstanding quantity to pack of 10 units, but only 7 units are available, the
program would assign a quantity to pack of 7 units.

Reserved: The Qty. to Pack field for each item will be automatically populated with the quantity of the item that
was reserved on the corresponding sales line.

If mistakes are made or you simply wish to restart the planning process, you can click Select > Reset to reset the
value in the Qty. to Pack field for all items to zero.

Note

When a selection option is used to determine package quantities, any existing values in the Qty. to Pack field
will be overwritten. For example, if we manually enter a quantity to pack for a particular item, then clicked on
of the options in the Select group, our manual entry would be overwritten by a calculated value.
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Creating Packages
Article • 4/3/2023 • 7 min read

The items that have been assigned to a sales order are packaged from the Sales Packaging page. You create a new
package record by clicking the Home tab and selecting one of the options in the Pack group:

Available package options are:

Selected: Every item for which a value has been assigned in the Qty. to Pack field on the Items FastTab is
included in the new package. The quantity of the item that is copied from the value in this field.

All: Every item is included in the new package. The quantity of the item that is packaged is copied from the value
in the Qty. Outstanding to Pack field on the Items FastTab.

Note

This option does not take availability considerations into account. For example, if we have an outstanding
quantity to pack of 10 units, but only 7 units are available, the program would still assign a 10 units to the
package.

Available: Every available item is included in the new package. The quantity of the item that is packaged is
copied from the value in the Qty. Outstanding to Pack field on the Items FastTab, but will not exceed the
amount in the Avail. Quantity on Hand field. For example, if we have an outstanding quantity to pack of 10
units, but only 7 units are available, the program would assign 7 units to the package.

Reserved: Every reserved item is included in the new package. The quantity of the item that is packaged is
copied from the quantity of the item that was reserved on the corresponding sales line.

Aggregate: Combines existing package records together into a larger package. If mistakes are made or you
simply wish to restart the packaging process, you can click Pack > Refresh to reset the value in the Qty. to Pack
field for all items to zero.

When you select a package option, a new package record is created. A sales order’s existing packages are displayed
on the Packages FastTab.
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The values in the displayed fields are for informational purposes only, and cannot be edited on the package line.
General information about each package (such as the number, status, and package date) is automatically
determined by the program when the package record is created. Other settings (such as the shipment method,
shipping agent, and shipping agent service) are copied from corresponding settings on the sales order from which
the package was created. Some package values (such as the carton type and carton type code) are determined by
default settings that were entered when the Aptean Pack and Ship solution was initially set up.

Depending on setup, the package’s weight may be calculated automatically by the program or may be capture by a
scale.

A package’s weight is based on the weight of each item within it. Each item’s weight is multiplied by the quantity of
the item that has been assigned to the package. The sum of these values is presented as the total weight of the
package. There are multiple ways in which an item’s weight may be determined:

If Aptean’s bcERP product has been deployed, it is possible to assign a weight value to an item’s unit of measure.
If this setup has been performed, it will be used to calculate an item’s weight.

If weights have not been assigned to an item’s unit of measure, this value may be defined on the Foreign Trade
FastTab of the Item card.

Information about a package’s contents is presented, as well. The Package Lines field displays the number of lines
that exist for the package, while the No. of Units (Base) field displays the total number of item units that have been
assigned to the package. You view the underlying package details that comprise one of these numbers by clicking
on the value in the desired field. The program will present a list of the package’s contents.
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Aggregating Packages
Article • 6/4/2023 • 4 min read

If multiple packages exist for a sales order, it is possible to combine them together into a single package. You must
indicate which packages will be combined by placing a check mark in the Selected field on the relevant package
lines.

By default, you can also indicate the type of package into which the selected packages will be combined by
selecting an option in the Packaging Type field on the Options FastTab.

Once you have selected the appropriate packages, you can combine them by clicking Pack > Aggregate. The
program creates a new package record, to which it then assigns the contents of the selected packages.

If a packaging type was defined in the Options FastTab, this value will be assigned to the new package record. If a
package type was not defined, however, then the program will automatically assign a packaging type that is one
level greater than the packaging type of the selected packages. For example, if we select multiple packages with an
assigned packaging type of 0 – Carton or Case and aggregate them into a single package, this new record’s
packaging type will be 1 – Pallet or container larger than a carton.

When packages are aggregated into a new package, a unique carton number is generated for each original
package, then assigned to the relevant package contents. In this way, it is possible to view the contents of a package
record that is comprised of multiple cartons on a carton-by-carton basis.
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Package Records
Article • 4/3/2023 • 12 min read

Each package record has its own card, one which information about the package can be viewed and various
activities can be performed against it.

After creating a package in the Sales Packaging page, you can open the package’s card by clicking the value in the
No. field on the appropriate package line.

You can also view a list of a sales order’s existing packages directly from the sales order itself by clicking the Home
tab and, in the Ship group, selecting the Packages option. The program will display a list of packages.

You can view a package’s card from this list by choosing the relevant line, then clicking Manage >Edit or View.

Regardless of the manner in which the Package Card is opened, the page looks the same.

General information about the package record is displayed on the General, Shipping, and Other FastTabs. Many of
these values are copied from either the sales order for which the package was created or default settings that are
automatically assigned to all new package records.

Some of a package’s assigned values can be edited directly on the Package card. For example, if it is necessary to
manually enter or override a package’s calculated weight, this information can be entered in the Weight field.
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The current status of the package is displayed in the Status field. A package’s status can be one of the following:

Open: The packaging process is still ongoing, and the package can accept additional contents. This status is set
manually by a user who wants to add items to a packaged.

Packed: The package has been fully packed and cannot accept additional contents. New package records are
automatically assigned a status of Packed, but this value can be manually changed, if desired.

Ready for Shipping: The package has been packed and deemed ready for shipment. This status can be set either
manually by a user or automatically by the program when the package is released from the Pack Scanning
window.

In Shipping: The package is in the process of being shipped as part of a shipping batch. This status is set
automatically by the program when the package is assigned to a shipping batch.

Shipped: The package has been shipped. This status is set automatically by the program when the shipping
activity has been posted.

Cancelled: The package was initially shipped, but then voided. This status can only be assigned if the Aptean
Pack and Ship solution is processed through Aptean ship integrated shipping, as it is through Aptean ship that
the voiding activity takes place.

Additional information about the package’s origin is displayed in the Carton Type field. This value may be initially
determined by default settings, but can be manually changed on a package-by-package basis. A package’s carton
type can be one of the following:

Re-pack: the package contents existed in their own separate packaging, and were combined together through
an in-house re-packing activity.

Self-Contained: the package contents are in their original packaging.

If a package record was created as the result of a re-pack activity, additional information about the package can be
included in the Carton Type Code field. It is possible to define a code for each type of standard carton into which
items are re-packaged. For every carton type code, package dimensions can be specified. As with the carton type,
this code may be initially determined from default settings, but can be manually changed if desired. Only re-packed
packages can have a carton type code; because self-contained packages exist in their original packaging, there is no
need to define a particular code to identify a standard carton type in which they reside.

The No. of Cartons field on the General FastTab displays the quantity of other packages that are contained within
the currently opened one. This is useful if the package record was created through the aggregation of other
package records, as it provides visibility to the packages within it. For example, if we aggregate 3 cartons into a
single pallet, the No. of Cartons field for the pallet’s package record would be a value of 3. You can click the
AssistButton to the right of this field to view the Package Cartons page, which lists each carton’s contents. It is also
possible to manually create carton records on this page.

The Package Contents FastTab displays the contents of the package.
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A separate line exists for each item that is contained within the package. Please note that, if a package contains
multiple smaller packages within it, and these smaller packages contain the same item, the line for that item on the
Package Contents FastTab will present the total quantity from all packages. For example, Package A contains 10
units of an item, while Package B contains 5 units. If we aggregate these packages into Package C, the package
content line for our item will indicate a quantity of 15 units has been packed.

For each item, the quantity that is awaiting shipping is displayed in the Qty. Outstanding field, while the quantity
that you wish to ship is entered in the Qty. Packed field. Initially these values will be identical, but if you wish to
modify the packed quantity of a particular item, you can re-open the package and make the necessary adjustments
directly in the Qty. Packed field. When a shipping activity is recorded, this value is added to the Qty. Shipped, and
the Qty. Outstanding field is decremented accordingly.

There are a number of activities that can be performed for a particular package record. These features are accessed
by clicking the Home tab and selecting one of the options in the Process group:

Available processing activities are:

Add Content: Displays a list of available items that can be added to the package.

Note

The package’s status must be Open if items will be added to it.

Add Package: Displays a list of other package records that have been created for the relevant sales order.
Selecting one of these packages and clicking OK will add it to the package from which the list was opened. The
added package’s contents will be included in the Package Contents FastTab, and the No. of Cartons field will be
updated accordingly.

Calculate No. of Cartons: If carton records were manually created for a package on the Package Cartons page,
selecting this option will instruct the program to calculate the number of cartons that exist for the package, then



Aptean Pack and Ship

Page 123 of 159

update the No. of Cartons field with this value.

Change Status: Presents a list of package status options. You can change a package’s status to Open, Packaged,
or Sent to Shipping. Selecting one of these options and clicking OK will update the package’s status.

Open: Changes the status of a packed package to Open.

Close: Changes the status of an open package to Packed.

Shipping: If a package has not been assigned to a shipping batch, selecting this option will create a new
shipping batch record and assign the package to it. If the package has already been assigned to a shipping
batch, selecting this option will open the existing record.

Move to My Station: It is possible to designate separate packing stations, then assign these stations to different
user. If this setup activity has taken place and a user selects the Move to My Station option for a particular
package record, the package will be assigned to that user’s defined packing station.

Track Package: If the package record has an assigned tracking number, it is possible to track its shipment status.
When setting up shipping agents, it is possible to associate an internet address to a shipping agent code. If you
utilize the track package feature from a particular package record, a web browser will automatically be opened
to the internet address that has been specified for that package’s defined shipping agent. If the internet address
asks for a tracking number, the package’s tracking number will automatically be entered and tracked.

In addition to these activities, you can print a package label by clicking Print > Label. There are a number of
different label formats that can be assigned to package. To obtain a view of the available label formats, see Label
Formats.
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Shipping
Article • 4/3/2023 • 8 min read

Once the contents of an outbound document such as a sales or transfer order are packaged, they are ready for
shipment. This shipping activity can be managed from the Shipping Batch card, which is accessed directly from a
source document such as the Sales Order, Transfer Order, and Warehouse Shipment page.

Note

The Shipping Batch card is a tool that can assist the user in reviewing and managing shipping activities for
outbound activities. It is not necessary to work with the Shipping Batch card in order to ship packages. If there
is no need to review the shipping information, manage freight and handling costs, or print any related
shipping documents, you can post the shipment of packages directly from the outbound document. As part of
this shipping process, a shipping batch will be created and automatically posted by the program.

There are multiple ways in which the Shipping Batch card can be accessed for a document:

With the relevant source document open, click Actions > Ship > Shipping Batch.

From the Packaging window in which package records are created, click Actions > Function > Shipping Batch.

If the Shipping Batch card is opened from a source document for which no shipping batch record currently exists,
the program will automatically create a new shipping batch record. If a shipping batch already exists for the source
document, it will be presented to the user.

General information about the shipping batch is displayed on the General FastTab. Many of these values are copied
from the corresponding settings on the source document from which the shipping batch was created. Some of
these values can be edited directly on the Shipping Batch card. When the shipping batch is posted, any changed
values will be copied back to the relevant source document. For example, if we create a shipping batch for a sales
order and change the shipment method code, posting the shipping batch will result in the program automatically
updating the shipment method code on the sales order.

The Package Details FastTab displays the packages that have been assigned to the shipping batch.
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A separate line exists for each package that is a part of the shipping batch. The values in the displayed fields are
copied from the corresponding package record. General information about each package (such as the number,
status, location code, and weight) is presented on each line. Most of these values cannot be edited directly on the
package detail line, but rather must be changed on the Package card. You can open the package’s card by clicking
Package > Card on the action menu.

You can open or close one or more package records directly from the Shipping Batch page. To do so, choose the
package detail line or lines that you want to change, then click Package > Open Package(s) or Close Package(s) on
the action menu. The status of the packages in the selected lines will be updated accordingly.

If an issue arises with a particular package and you want to ensure it is not inadvertently shipped before the
problem is resolved, you can place a check mark in the Hold field for the appropriate package detail line. The
program will not ship and post a shipping batch if any of its included packages have been placed on hold.

You can also print documents from the Shipping Batch page by clicking Print on the action menu.

Content List: prints the contents of each package that has been assigned to the shipping batch. A new page will
be created for each package within the shipping batch.

Label: prints a label for each package that has been assigned to the shipping batch. Each label will be printed
according to the label format that has been assigned to the relevant package.

You can now pack the order from Shipping Batch. It can then finally be shipped via EasyPost Multi Carrier Integrator.
You can create order, buy it, insure it, generating label to obtain Tracking No. and Shipping Labels. Commercial
Invoice is saved in Shipping Batch and Packages.
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You can print the Carrier Label obtained in PNG from Shipping Batch.
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Posting Shipments
Article • 4/3/2023 • 6 min read

Once the information within each package that has been assigned to a shipping batch is reviewed and any
necessary information has been entered, you can post the shipment. Depending on the level of management a
company wishes to utilize in the processing of its packages, posting can occur from one of three areas: the source
document itself, the Sales Packaging page, or the Shipping Batch page. All three pages can record shipping activities
solely through Business Central, Dynamics NAV or through a transmission to a ShipRush solution.

Source Document
It is possible to fully automate all or some of the packing and shipping activities that are required to successfully
process a shipment by instructing the program to create the relevant records directly from the outbound document.
Click Actions > Ship > Pack and Ship or Post.

Pack and Ship: The program will automatically create package records for the items on the outbound document
lines, then add them to a shipping batch. Any shipping labels that have been assigned to the customer will also
be printed as part of this process. If ShipRush is integrated with Aptean Pack and Ship, information from the
shipping batch will be automatically sent to ShipRush, as well.

Post: Posts shipments in Business Central and Dynamics NAV. Posting can only occur when the outbound
document’s items have been packed. Selecting this option will open the Post Packages page.

On the Posting FastTab page, you can specify a number of settings that will impact the package posting process.
Fill in the fields as follows:

Posting Date: Enter the date on which the shipment will be posted. The value in this field will initially default
to the work date, but it can be manually changed, if necessary.

Selection: Select the type of posting activity you want to perform. You can either Ship or Ship and Invoice
the shipping batch’s assigned packages. Depending on setup, it may be that the ability to ship and invoice a
package a shipping batch from the Post Packages page is not permitted.
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Print Shipment: Place a check mark in this field to instruct the program to print assigned shipping
documents as part of the posting process. Depending on setup, it may be that this option is selected by
default.

Print Invoice: Place a check mark in this field to instruct the program to print assigned invoicing documents
as part of the posting process. Depending on setup, it may be that this option is selected by default. Please
note that, if the posting process does not include invoicing activities, the setting in this field is irrelevant.

Print Label(s): Place a check mark in this field to instruct the program to print labels for each package as part
of the posting process.
The Package/Shipment Information FastTab contains general information about the pending posting activity,
including the number of pallets, cartons, and individual units that will be shipped, as well as the net weight of
the shipment. The values in the displayed fields are for informational purposes only, and cannot be edited.
Once you have entered any necessary settings and reviewed the shipping information, you can post the
shipping batch by clicking Process > Post on the action menu. As with any shipment posting, entries will be
made to the item ledger for each item that was included in the shipping batch, indicating negative
adjustments based on the posted quantities.

Pack, Ship and Post: Combines the functionality of the previous two posting options. The program will
automatically create package records for the items on the outbound document lines, then add them to a
shipping batch. Following this, the Post Packages page will be opened, from which the shipments can be posted
in Business Central and Dynamics NAV.

Note

You can perform the Pack and Ship, Post, and Pack, Ship and Post functions only if the shipping agent code is
specified on the relevant Sales Order page.

Sales Packaging
If you wish to manage the creation of package records but do not need to review shipping information, manage
freight and handling costs, or print any related shipping documents, you can post the shipment of packages from
the Sales Packaging window. The following posting options are available:

Post: Click the Home tab and, in the Process group, select the Post option to post the shipment of packages in
Business Central. Selecting this option will open the Post Packages page, from which the shipments can be
posted in Business Central.

3rd Party Integration Shipping Options: If the 3rd Party Integration is used with Aptean Pack and Ship, it is
possible to send the shipment of packages to that 3rd Party Integration from the Sales Packaging page by
clicking the Home tab and, in the Ship group, selecting the Ship option. A new shipping batch will be created for
the relevant package records, and the information from this shipping batch will be transmitted to the 3rd Party
Integration as a new shipment record.
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Shipping Batch
Article • 5/20/2025 • 7 min read

The Shipping Batch page represents a pending shipment, and is the final stage of packing and shipping process. If
you do not wish to automatically record and post records earlier, you must perform these activity here. The
following posting options are available:

Post: Click Process > Post on the action menu to post the shipment of packages in Business Central. Selecting
this option will open the Post Packages page, from which the shipments can be posted in Business Central.

3rd Party Integration Shipping Options: If the 3rd Party Integration is used with Aptean Pack and Ship, it is
possible to send the shipment of packages to that 3rd Party Integration from the Sales Packaging page by
clicking the Home tab and, in the Ship group, selecting the Ship option. A new shipping batch will be created for
the relevant package records, and the information from this shipping batch will be transmitted to the 3rd Party
Integration as a new shipment record. If incorrect information was inadvertently sent to, a Void option exists that
will instruct the 3rd Party Integration to void the corresponding shipment record.

Note

You can view the Shipment Status and Shipment Status Message field values based on the response of
the selected shipping batch. The available options for the Shipment Status field are Success and Failure.
The Shipment Status Message field description gets updated based on the Shipment Status field.

Ship & Post: Combines the functionality of the previous two posting options. The program will transmit
information from the shipping batch to the 3rd Party Integration as a new shipment record. Following this, the
Post Packages page will be opened, from which the shipments can be posted in Business Central.

When a shipping batch is posted, it will be deleted from the list of active records. The information is maintained for
historical purposes however, as all the data from the shipping batch is copied to a new posted shipping batch

record. Posted shipping batch records can be viewed by entering posted shipping batches in the  search bar
and choosing the related link.

To Get the Shipping Details

Prerequisites

On the Ship Setup page:

Ensure that your license is validated.

Ensure that ApteanShip is selected in the Rate Shopping API field.
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Ensure that package and shipping batch number is selected in the Package Nos. and Shipping Batch Nos. fields
on the Numbering FastTab.

Ensure that the GS1 Company Prefix field is filled on the General FastTab.

To get the shipping details for the sales order:

1. Choose the Search icon , enter sales orders and choose the related link.
The Sales Orders page opens.

2. On the action menu, select New.
The new Sales Order page opens.

3. In the Customer Name field, select the customer card.

4. Fill in all the necessary fields.

5. On the action bar, go to Release > Release.

6. Choose the Search icon , enter packaging and choose the related link.
The Sales Packaging page opens.

7. On the Options FastTab, select the packaging type that you want to use in the Packaging Type field.

8. On the action bar, go to Pack > All and go back to the Sales Order page.

9. Choose the Search icon , enter shipping batch and choose the related link.
The Shipping Batch page opens.

10. In the Shipping Agent Code and Shipping Agent Service Code fields, select the required code.

Note

To get the rates: 1. Choose the Search icon ![](assets/BC-icons/search-icon.png), enter _add freight and
handling_ and choose the related link. The Edit – Sales Order Add Freight page opens. 2. On the action
bar, select Get Rate. You can select the rates from the list of options.

11. On the action bar, select Carrier > Ship.

On the Shipping Agents page, the Integrated Carrier checkbox should be selected for the specified shipping
agent code to ship the sales order.
After you ship the sales order, the following fields are filled automatically:

Shipment ID

Freight Amount

Shipment Date/Time
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Estimated Delivery

Tracking No.

Tracking URL

Note

The Shipping Agent Code and Shipping Agent Service Code fields value can be directly entered on the
Warehouse Shipment page for shipments. If these fields are empty, the system will inherit values from the
associated Shipping Batch. If the Shipping Batch also doesn't specify values, the system will default to the
values from the related Sales Order.

You can also print the documents by selecting Print > Print All Documents on the action bar.
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Freight
Article • 4/3/2023 • 4 min read

Shipments typically have freight and handling charges that reflect the cost of shipping. Both the manner in which
these charges are calculated and the party that is responsible for paying them will vary from situation to situation.
For example, it may be that a company includes freight charges on its invoices to its standard customers, but
absorbs this cost on shipments to its preferred clients.

The Aptean Pack and Ship solution provides a number of different ways in which shipping costs can be calculated
and applied to outbound activities. Varying levels of automation are available, and in environments in which the 3rd
Party Integration is utilized, it is possible to instruct Business Central to obtain freight charges from the integration.

Freight Type
There are different ways by which shipping charges can be assigned to an outbound document. A freight calculation
method is assigned to a sales order in the Freight Type field on the Shipping FastTab.

If any billing rules have been defined for the sales order’s assigned values (such as the customer or shipping agent),
the program will automatically assign the sales order’s freight type from the billing rule’s default settings. This value
can be manually changed, if desired.

There are four available freight types that can be assigned to a sales order:

No Charge/Included: Freight will not be charged to the customer. A freight line will be added to the sales order,
but the price will not be populated. The cost of freight (either entered manually or obtained from the 3rd Party
Integration) will still be included, however. While No Charge and Included are presented as two separate options
in the Freight Type field, they work in exactly the same manner; the only reason they exist as separate options is
that a company may prefer using one term over another, as they have slightly different connotations (with “no
charge” indicating that freight is not being charged to the customer, while “included” indicating that freight has
been charged and is included in the sales price of the ordered items).

Actual: The customer will be charged the actual freight amount. A freight line will be added to the sales order
with a populated price that is initially identical to the cost of freight (either entered manually or obtained from
the 3rd Party Integration). This will automatically replace any freight values that were manually added to the
sales order by the user.
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Note

Any markup methods have been defined for the associated billing rule, the freight price on the sales order
will be automatically adjusted according to its parameters.

Quoted: The customer will be charged a quoted freight amount. By default, a freight line will be added to the
sales order with a populated price that is initially identical to the cost of freight (either entered manually or
obtained from the 3rd Party Integration). However, if the user manually overrides the freight price prior to
posting the document, this value will be assigned as the freight price on the sales line. The cost will remain the
same.

Note

Any markup methods have been defined for the associated billing rule, the freight price on the sales order
will be automatically adjusted according to its parameters.
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Freights Assignment
Article • 4/3/2023 • 12 min read

A sales order’s freight and handling charges are initially entered on the shipping batch to which the order’s
packages have been assigned.

If the 3rd Party Integration is being utilized in conjunction with Aptean Pack and Ship, it is possible to configure that
integration to calculate freight amounts for shipment records that are transmitted from Business Central. These
calculated amounts will be automatically assigned to the shipping batch record. If the 3rd Party Integration is not
utilized, these values must be manually entered on the Shipping Batch page.

When the sales order is posted, the program will automatically create new sales lines for any freight and handling
amounts that have been assigned on the related shipping batch.

Depending on how the related billing rule has been configured, the program will either create a separate line for
individual freight and handling charges, or combine both values into a single line.

The values in the Type, No., and Description fields are copied from the corresponding setup on the related billing
rule. The quantity will always default to one, while the unit price will be determined according to the sales order’s
assigned freight type. The program multiplies this price by the quantity of one to obtain the line amount.

Added a new table Rate Shopping Buffer for Rate Shopping functionality to create order. You can show rates
fetched by populating in this table by enabling user to shop from available rates.
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Select Sales Order > Ship > Add Freight and Handling to view.

A new field Get Rate action is added in the Sales Order Add Freight page. Now it can create order with EasyPost,
fetch rates and show in another page to enable user to select from them.

Select Get Rate to view the Rate Shopping Result.

Sales Order Add Freight page opens and selected rates are updated.
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Manual Freight Assignment
If the sales order’s freight type is Quoted, it possible to manually assign a freight amount prior to posting. This
activity takes place on the Sales Order Add Freight page, which is accessed by clicking Actions > Ship > Add Freight
and Handling on the action menu.

Information about the sales order is displayed on the General FastTab. Although the data in these fields may be
useful for information purposes, they are not editable on the Sales Order Add Freight page. If changes need to be
made to these values, they must be made on the source document itself.
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Shipping costs can be entered or adjusted on the Freight & Handling FastTab.

To assign shipping charges to a sales order, fill in the fields as follows:

Location Code: Enter or select the location to which shipped costs will be recorded. The value in this field will
default to the location that has been assigned to the related sales order, but it can be manually changed, if
desired.

Freight Amount: Enter a freight charge for the sales order.

Handling Amount: Enter a handling charge for the sales order.

If any markup methods that have been defined for the sales order’s associated billing rules, they will be added to
the sales order’s freight and handling amounts and displayed in the Calculated Freight and Handling section of the
Freight & Handling FastTab. For example, in the screenshot above, we have entered a freight amount of $25.00, but
a billing rule exists that is adding an additional $15.00 to our freight charge, resulting in a calculated freight amount
of $40.

When you have entered and reviewed any necessary freight and handling amounts, you can assign them to the sales
order by clicking the OK button. New lines for the freight and handling amounts will be added to the sales order.

Note

The manual assignment of shipping charges will only be applied when the sales order’s freight type is Quoted.
If the sales order has another freight type, any manually assigned freight charges will be automatically override
according to that freight type’s parameters when the document is posted.

Freight Calculation Scenario
To better illustrate the way in which shipping charges are applied to a sales order based on that order’s freight type,
consider the following scenario. We create a number of packages for a sales order, then ship them through the 3rd
Party Integration. The 3rd Party Integration calculates a freight amount of $35.00, which it assigns to the related
shipping batch. Before posting the sales order, we open the Sales Order Add Freight page and assign a freight
amount of $40. We then post the sales order, and a new line for freight is added. Depending on the sales order’s
assigned freight type, the freight line’s price and cost amounts would be as follows:
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Freight Type Unit Price Unit Cost

No Charge/Included $0.00 $35.00

Actual $35.00 $35.00

Quoted $40.00 $35.00

It is also important to note that any markup methods that have been defined for the associated billing rule will be
automatically applied to actual and quoted freight amounts. Continuing with our example, let us also assume that
the sales order’s customer has a billing rule which instructs the program to mark up freight charges by $3.00. In such
a scenario, the freight line’s price and cost amounts would be as follows:

Freight Type Unit Price Unit Cost

No Charge/Included $0.00 $35.00

Actual $38.00 $35.00

Quoted $43.00 $35.00

If multiple billing rules apply to a sales order, they will all contribute to the final shipping charges. For example, if a
sales order’s assigned customer and shipping agent both have defined billing rules with assigned markup methods,
both markup amounts will be applied to the order’s shipping charges.
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Warehouse Environments
Article • 4/3/2023 • 1 min read

The Aptean Pack and Ship solution can be utilized in warehouse environments that employ varying levels of
inventory control. In warehouse environments, shipments are not posted directly from source documents such as
sales or transfer orders, but rather warehouse shipments, which contain the contents of one or more source
document.

There are two ways in which packages can be created from a warehouse shipment:

Warehouse Packaging: Similar to the Sales Packaging functionality that is used to create packages from sales
orders.

Pack Scanning: A warehouse-specific feature in which packages can be created via barcode scanning. This can
significantly expedite the data entry process.
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Warehouse Packaging
Article • 4/3/2023 • 2 min read

Packages can be created directly from warehouse shipments on the Warehouse Packaging page, which is accessed
from a warehouse shipment record by clicking Actions > Ship > Packaging.

The Warehouse Packaging page displays the items that have been assigned to the warehouse shipment from which
it was opened. You manage the packaging of these items from here.

The process for creating packages from the Warehouse Packaging page is virtually identical to what occurs on the
Sales Packaging page. The only difference is the source document (warehouse shipment instead of sales order) from
which packages are created. To learn more about the available functionality of the Warehouse Packaging page, as
well as the package records that are created, please refer to Sales Packaging.
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Warehouse Shipping
Article • 4/3/2023 • 7 min read

It may be that packages from multiple warehouse shipments will be included as part of the same shipping activity.
For example, perhaps we have multiple warehouse shipments for the same customer that are all scheduled to ship
on the same day. In such a scenario, it makes sense for us to combine the packages from all shipments into a single
activity.

It is possible to combine packages that are awaiting shipment to the same shipment activity on the Warehouse
Shipping page.

The Warehouse Shipping page allows you to assign packages together as part of a single shipment. To assign a
package, fill in the field as follows:

Add Package No.: Enter or use the AssistButton to select the package record that you want to include in the
shipment. Only packages with a status of Sent to Shipping may be assigned to the warehouse shipping lines. It is
not possible to enter packages that have already been assigned to a shipping batch.

When a package is entered in the Add Package No. field, a new shipping batch is created, to which the package is
assigned. The package’s status is also updated to In Shipping at this time. A new line displaying the package is
entered in the area below the Add Package No. field.

General information about each package (such as the number, status, location code, and weight) is presented on
each line. Most of these values cannot be edited directly on the package detail line, but rather must be changed on
the Package card. You can open the package’s card by clicking the Home tab and, in the View group, selecting the
Card option. It should be noted, however, that all packages which are included as part of the same shipment must
share certain characteristics, and making a change to one of these values directly on the package card may prevent
it from being shipped. For example, if we create a shipment for a number of packages with an assigned shipping
agent of UPS, then change one package’s shipping agent to FedEx, this package can no longer be included with the
others.

If an issue arises with a particular package and you want to ensure it is not inadvertently shipped before the
problem is resolved, you can place a check mark in the Hold field for the appropriate package detail line. The
program will not ship and post a warehouse shipment if any of its included packages have been placed on hold.

Information about the shipping batch that has been assigned to the currently selected line is displayed on the
Shipment Information FastTab.
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The values in the fields are copied from the related shipping batch record. It is possible to enter or modify the
shipping batch’s freight amount and tracking number directly from the Warehouse Shipping page.

If a package was incorrectly included as part of the shipping activity or is not ready for shipping, you can change its
settings by clicking Functions action.

Available functions are:

Return to Queue: The package will be removed from the shipping batch, and its status will be set to Ready for
Shipping. The package is now ready for assignment to another shipping batch.

Return to Packing: The package will be removed from the shipping batch. The program will also ask the user if
the package should be re-opened. Depending on the user’s response, the package’s status will be set to either
Packed or Open. The package is now ready for assignment to another shipping batch.

Delete Package: The package record will be deleted. The package contents are now available for inclusion in a
new package.

Posting Shipments
Once the desired packages have been entered in the Warehouse Shipping page and any necessary adjustments
have been made to these records, you can post the shipment. If the Aptean Pack and Ship solution is being run in
conjunction with the 3rd party Integration, data from the shipment can be sent to the 3rd Party Integration by
clicking the Home tab and, in the Function group, selecting the Card option. The shipping batch will open and
present the pending shipment. This will allows for the review of information before finalizing the shipment.

To post the warehouse shipment in Business Central, click Process > Post. This will open the Post Packages page,
from which the shipments can be posted in Business Central.

When a shipping batch is posted, it will be deleted from the list of active records. The information is maintained for
historical purposes however, as all the data from the shipping batch is copied to a new posted shipping batch
record. Posted shipping batch records can be viewed from the accessed by clicking Ship > History.
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Pack Scanning
Article • 12/18/2023 • 24 min read

An alternative method to creating packages in a warehouse environment is via the Pack Scanning page. This feature
allows for the instant creation of packages through the inputting of an identification number. While this could be
performed manually through the entry of an item number, it also facilitates barcode scanning, as it may be that a
scanned UPC is the device through which records are created.

The Pack Scanning functionality creates packages in response to warehouse shipment records only. For this reason,
it is not possible to implement Pack Scanning in a non-warehouse environment in which warehouse shipments are
absent.

There are multiple ways in which the Pack Scanning page can be accessed:

With the relevant warehouse shipment open, click Actions > Ship > Pack Scanning.

From the menu by entering Pack Scanning in the  search bar.

The Source Document No. filter on the Options FastTab identifies the warehouse shipment for which package
records are being created.

If the Pack Scanning page is opened directly from a warehouse shipment, this filter will be automatically set with
that shipment’s number. When the Pack Scanning page is opened from the menu, this field will be blank, and you
must specify the number of the shipment for which you want to create packages. When a shipment is specified, the
relevant customer information is automatically displayed in the Address Information area to the right.
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If you specify the wrong shipment, or wish to work with a different one, you can remove the filtered value by clicking
Process > Clear Filters on the action menu. It is not possible to clear the filtered document number when the Pack
Scanning page is opened directly from a warehouse shipment.

Creating Packages
Before you can begin to create packages, you must determine certain parameters. This information is specified on
the Options FastTab.

Fill in the fields as follows:

Packaging Type: Select the type of package into which items will be placed. The selected packaging type can be
Carton or Case, Pallet or container larger than a carton, Container larger than a pallet, Undefined container type,
or Internally defined for intra-company use. It is also possible to define a default packaging type for all
packaging activities. If a default exists, this field may be left blank, and the program will automatically use the
assigned default for new packages.

Batch Pack: Place a check mark if you want to allow for batch packing. When batch packing is enabled, it is
possible to enter an item number or barcode, then specify the quantity of that item that will be added to a new
package. If this field is left unchecked, every unit of an item must be individually assigned to packages.

Once the necessary settings have been designated, you can enter the item you want to pack in the
Item/UPC/Package field on the Options FastTab.

As the name of the field indicates, there are different types of value than can be recorded. It is possible, for example,
to enter an item number. However, if UPC information has been set up for items in Business Central, this information
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is also valid. This allows for integration with barcode scanning, as the user has the ability to scan an item’s barcode,
and have that information entered in this field.

Once a value is entered in the Item/UPC/Package field, it must be validated. Validation can occur by exiting the
field, or refreshing the page. When working with barcode scanners, validation can occur as part of the scanning
process, so that data is immediately validated at the time of scanning.

The validation process has a number of different outcomes:

If the entry in the Item/UPC/Package field corresponds to an unpacked item that has been assigned on the
filtered warehouse shipment, a single unit will be added to an open package record. If no open package records
currently exist, a new one will be created.

If the entry in the Item/UPC/Package field corresponds to an unpacked item that has been assigned on the
filtered warehouse shipment and a check mark has been placed in the Batch Pack field, the user will be
prompted to enter the quantity of the item that will be packaged.

This quantity will be added to an open package record. If no open package records currently exist, a new one will be
created.

The maximum batch pack quantity cannot exceed the item’s current unpacked quantity. For example, if we had a
warehouse shipment for 10 units of an item, and had already packed 6 units, our batch pack quantity could not be
greater than 4 units.

If the entry in the Item/UPC/Package field corresponds to an item that has been assigned on the filtered warehouse
shipment but has already been fully packed or an item that has not been assigned on the filtered warehouse
shipment, the program will indicate that there is nothing to pack.

A warehouse shipment’s existing packages are displayed in the lines beneath the Options FastTab.
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The values in the displayed fields are for informational purposes only, and cannot be edited on the lines. General
information about each package (such as the number, status, and package date) is automatically determined by the
program when the package record is created. Other settings (such as the shipping agent and shipping agent service)
are copied from corresponding settings on the warehouse shipment for which the package was created. Some
package values (such as the carton type code) are determined by default settings that were entered when the
Aptean Pack and Ship solution was being initially set up. Please click here to learn more about these setup activities.

Each package’s weight is initially calculated by the program.

A package’s weight is based on the weight of each item within it. Each item’s weight is multiplied by the quantity of
the item that has been assigned to the package. The sum of these values is presented as the total weight of the
package. There are multiple ways in which an item’s weight may be determined:

If Aptean’s bcERP product has been deployed, it is possible to assign a weight value to an item’s unit of measure.
If this setup has been performed, it will be used to calculate an item’s weight.

If weights have not been assigned to an item’s unit of measure, this value may be defined on the Foreign Trade
FastTab of the Item Card.

If an electronic scale has been integrated within the Business Central environment, it is possible to instruct Aptean
Pack and Ship to retrieve a package’s recorded weight by choosing the relevant package record in the Pack
Scanning page, then click Process > Get Weight on the action menu. The weight that has been recorded by the
scale will be copied to the selected package record’s Weight field.

Note

It is only possible to utilize this electronic scale integration in conjunction with using the PrintNode solution.

The No. of Cartons field on the package line displays the quantity of other packages that are contained within the
currently opened one. When a package’s type is larger than the Carton or Case setting, it is possible to assign
contain multiple cartons within it. You can click the AssistButton to the right of this field to view a list of each
carton’s contents.
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Additional visibility to a package’s contents is presented in the Pack Scanning Package Contents FastTab.

A separate line exists for each item that is contained within the package. The number of units within the package is
displayed in the Qty. Packed field. If an item is tracked via lot or serial numbering, visibility to this information is
provided, as well.

It may be that a shipment is comprised of multiple packages that are identical in terms of their contents and other
characteristics. In such a scenario, it is possible to expedite the packaging process by creating a single package
record that contains the necessary date, then click Process > Clone Package on the action menu. The program will
create a new package record, then copy the information and settings from the selected one to it. For example, if we
had a shipment for 30 units of an item that is comprised of 3 packages of 10 units apiece, we could create a
package record for 10 units, then utilize the Clone Package feature twice to quickly generate the necessary package
records.

Note

It is not possible to clone packages if a new package record’s contents will exceed the quantity of the
corresponding items on the warehouse shipment. Continuing with our example, it would not be possible to
create a fourth package of 10 units, since the original shipment quantity was for 30 units.

Manually Creating Packages
While the Pack Scanning page is intended to automate the package creation process, it is possible to manually
create package records from this page. It is also possible to manually create packages from the Warehouse
Packaging page, which is accessed directly from a warehouse shipment record. Depending on the particular needs
of an organization, it may be that one method is preferable over another.

To manually create packages from the Pack Scanning page, click the Home tab and, in the Process group, select the
Avail. to Pack option.

The Whse. Available to Pack page is similar to the Warehouse Packaging page. The Items FastTab displays the
items that have been entered on the relevant warehouse shipment’s lines, and include general information as well as
insight into various packing quantities. The Packages FastTab displays the package records that exist for the
warehouse shipment, and include general package information and warehouse shipment settings, as well as insight
into the package’s weight and contents.

To create packages from the Whse. Available to Pack page, you must indicate the amount of each item you wish to
pack in the Qty. to Pack field on the Items FastTab. If desired, you can manually enter these quantities. However, you
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can automatically populate the Qty. to Pack field for all items by clicking the Home tab and selecting one of the
options in the Pack group:

Available selection options are:

All: The Qty. to Pack field for each item will be automatically populated with the value in the corresponding Qty.
Outstanding to Pack field. Please note that this option does not take availability considerations into account. For
example, if we have an outstanding quantity to pack of 10 units, but only 7 units are available, the program
would still assign a quantity to pack of 10 units.

Available: The Qty. to Pack field for each item will be automatically populated with the value in the
corresponding Qty. Outstanding to Pack field, but will not exceed the amount in the Avail. Quantity on Hand
field. For example, if we have an outstanding quantity to pack of 10 units, but only 7 units are available, the
program would assign a quantity to pack of 7 units.

If mistakes are made or you simply wish to restart the planning process, you can click Pack > Reset option to reset
the value in the Qty. to Pack field for all items to zero.

When you have specified the quantities you want to pack for all items, you can assign them to a new package
record by clicking the OK button. The Whse. Available to Pack page will close, and a new package containing the
specified items is added to the Pack Scanning page.

Building Cartons
In which multiple levels of packaging exist, it may be that the user wishes to initially create the package record for
the larger package, then define the individual smaller packages that are contained within it. For example, suppose
we ship 30 cartons of items on a pallet, with each carton containing a single item. From a data entry perspective, it
may be easier for us to first create the pallet record, assign items to that pallet, and then generate the carton
records.

It is possible to instruct the program to generate carton records for a pallet’s assigned contents by using the Build
Cartons functionality. To use this feature, you must first create a package record on the Pack Scanning page that
does not have a packaging type of Carton or Case.

Items should be added to the package record using the standard pack scanning functionality. Once all items have
been added to the package, you can generate individual carton records for them by clicking Process > Build
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Cartons option. The program will create a carton record for each item that has been assigned to the package, and
the No. of Cartons field on the package line will be updated accordingly.

Note

The Build Cartons feature should only be utilized if each item that is included on a pallet is stored in its own
carton, because the program will automatically build a carton for each unit on the pallet.

Processing Packages
When an item that had been entered in the Item/UPC/Package field is validated, it is added to an open package
record. Items can continue to be added to a package record if its status is open. To instruct the program that a
package is full and can no longer accept additional items, you must finish the package by clicking Process > Finish
Pkg. option. The package’s status changes to Packed, and changes can no longer be made to it. A finished packaged
can be re-opened at any time by selecting the relevant line, clicking Process > Reopen Pkg. option.

If packing rules exist for a packaged item, it may be that a package is automatically finished once a designated
number of units is added to the package. For example, if we instruct the program to automatically finish a package
once 2 units of an item have been packed within it. Automatically finished packages can still be manually re-opened
by the user.

If an item that had been entered in the Item/UPC/Package field is validated and no open package records currently
exist, a new one will be created. If multiple open package records exist, the item will be added to currently-selected
one.

Once all items on a shipment have been assigned to package records, and all packages have been finished, it is
necessary to release them for shipping. Click the Process group, select one of the available release options:

Release All: The program will automatically update the status of all scanned packages to Ready for Shipping.
These packages may now be assigned to a shipment in the Warehouse Shipping page. The Release All feature is
useful in environments in which packaging and shipping activities are performed as separate activities, as it
readies completely packaged records for inclusion as part of a shipment at a later time.

Release and Ship: The program will automatically create a shipping batch record and add all packages to it. The
shipping batch can then be processed normally. To learn more about how to process and post shipping batches,
please refer to the Shipping Batches section. The Release All feature is useful in environments in which
packaging and shipping occur as a single activity, as shipping batch can be immediately posted following its
creation.

Note

Depending on setup, it may be that certain documents such as labels and contents lists are automatically
printed as part of the release process.
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Shortcut keys
The actions on this page have the following shortcut keys:

S.No Action Shortcut key

1 Labels Ctrl+G+F10

2 Reopen & Pkg. Ctrl+Shift+B

3 Get Weight Ctrl+Shift+F9

4 Shipping Batch Ctrl+F1

5 Close Pkg. Ctrl+M

6 Release All Ctrl+\

7 Release and Ship Ctrl+F2

8 Ship Ctrl+F8

9 Ship and Post Ctrl+F7
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History
Article • 4/3/2023 • 5 min read

All historical documents related to inventory activity can accessed from the Ship History menu, which is accessed by
clicking Departments > Ship > History.

Historical documents are available for both standard Business Central records such as sales orders and warehouse
shipments, as well as features that are unique to the Aptean Pack and Ship solution such as packages and shipping
batches. You can select any of these menu options to view the corresponding historical records.

Document Tracking
As a company records more and more shipments, the number of historical records will grow, making it more difficult
to obtain insight into the packages that are related to a particular activity. To assist the user in this process, the
Document Tracking page was developed. This page allows the user to specify a type of document or even a
particular document number, and the program will present any packages or other documents that are related to
these values.

The Document tracking page can be accessed from the Ship History menu by clicking Document Tracking.

When it is initially opened, the Document Tracking page is blank. To view documents, you must assign filter values:
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Fill in the fields as follows:

Document Tracking Type Code: Enter or use the Assist Button to select the document tracking type code that
represents the type of document you want to view. Document tracking codes are preconfigured values that are
associated to different types of Business Central documents.

Document No.: Enter the document or documents you want to view. You can use standard Business Central filter
expressions to enter a single document, multiple documents, or an entire document range in this field. If you are
using this in conjunction with the Document Tracking Type Code filter, be sure to enter a value in this field that
exists as a record for the selected document tracking type.

The area beneath the filter fields is a display of the documents that fit the criteria established by filters. If a
document tracking type code filter has been entered, all documents to which that code applies will be presented. If
a document number filter has been entered, only the specific document or documents will be presented.

In addition to the documents themselves, the Document Tracking page presents any package records that are
related to each displayed document. Package records are identified as “Packaging” followed by the record’s
currently status in parentheses. For example, a package with a status of Ready for Shipping would be presented as
“Packaging (Ready for Shipping)” on its document tracking line.

The Document Exists field indicates whether the document on the line still exists as a record within the program. A
document tracking entry is created for each document or package record at the time of its creation. If the record is
deleted from Business Central at some point, its document tracking entry remains, but the Document Exists field is
unchecked. This may provide insight into a particular document number that is no longer obtainable as a record in
Business Central.

For both documents and their related packages, basic information regarding their creation is included. If a
document exists, you can be open it by choosing the relevant line, then clicking the Process group, selecting the
Show option. It is also possible to run Business Central’s standard Navigate function against a document by clicking
the Process group, selecting the Navigate option. Navigating on a document will instruct the program to display
other types of records and entries that are related to it.



Aptean Pack and Ship

Page 153 of 159

Label Formats
Article • 4/3/2023 • 10 min read

There are a number of label formats provided with the Aptean Pack and Ship solution. Each one is identified by its
unique Business Cental report number. Label formats are assigned to customer records; when package labels are
printed, the program will use the format that has been associated to the relevant customer.

To assist in the determination of what format will best meet a company’s needs, sample copies of the available
Aptean Pack and Ship formats have been presented here.

UCC Package Label 1 (37046503)

UCC Package Label 2 (37046512)
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UCC Package Label 3 (37046513)

UCC Package Label 4 (37046514)
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UCC Package Label 5 (37046515)

UCC Package Label 6 (37046516)
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UCC Package Label 7 (37046517)

UCC Package Label 8 (37046518)
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UCC Package Label 9 (37046519)
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Barcode Scanning
Article • 4/3/2023 • 3 min read

When printing barcodes to a printer of less than 600 DPI (Dots Per Inch), the printer may not accurately reproduce
the exact bar and space ratios. This can result in a read error on the barcode scanner or verifier.

As a general rule the font size on printers with less than 600 DPI should be no smaller than 20 points. However, the
optimal font point size will depend on the type of barcode font being printed. Because an exact number of dots is
required to create the exact ratio of bar and space sequences, the optimal point sizes for a particular font are
oftentimes according to a particular multiple. For example, to properly print Code 128 fonts to a Zebra Thermal 203
DPI printer, the assigned point size should be a multiple of 6 (6, 12, 18, 24, 30, etc.). The chart below presents a
number of standard barcode font types, along with the font sizes that will yield the best results on the two types of
sub-600 DPI printer.

Note

If a company’s software does not support printing at the specified point sizes in the chart, then barcodes must
be printed at a point size larger than 20 points in order for them to function.

For additional information on barcode font types, including licensing parameters, please see
https://www.idautomation.com

Barcode Font Type Font Point Size Required to Match DPI of Printer When Printing Less Than 600

Code 39 (Version 5.1 or greater) 6, 12, 18, 24, 30, 36, and other multiples of 6

Code 128 (Version 5.1 or greater) 6, 12, 18, 24, 30, 36, and other multiples of 6

Codabar[^1] 5, 10, 15, 20

Interleaved 2 of 5[^1] 12.5, 25

MSI[^1] 6, 11.5

UPC/EAN 17, 22, 30

Universal Barcode Font 6, 12, 18, 24, 30, 36, and other multiples of 6

[^1]: In testing, Codabar, Interleaved 2 of 5, and MSI were very close to printing properly at the font sizes listed in
this chart. However, to create completely accurate ANSI grade A barcodes on low resolution printers, IDAutomation
recommends the Universal Barcode Font Advantage software package. This product creates accurate barcodes on
low resolution printers when printing at narrow to wide ratios of 2:1 or 3:1. The Universal Barcode Font Advantage
software also works on any operating system, code page, and locale, and creates Codabar, Interleaved 2 of 5, and
MSI, as well as other barcodes such as Code 128 and Barcode 3 of 9 as a single font.

https://www.idautomation.com/barcode-fonts/
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Troubleshooting
Article • 4/3/2023 • 3 min read

If the below error is encountered while using Aptean Pack and Ship functionality, please turn off DEP on your
machine by running the following:

In Techy terms:

bcdedit.exe /set {current} nx AlwaysOff

Then restart the machine.

In Standard terms:

Open System by clicking the Start button Picture of the Start button, right-clicking Computer, and then clicking
Properties.

Click Advanced system settings. Administrator permission required. If you're prompted for an administrator
password or confirmation, type the password or provide confirmation.

Under Performance, click Settings.

Click the Data Execution Prevention tab, and then click Turn on DEP for all programs and services except those I
select.

To turn off DEP for an individual program, select the check box next to the program that you want to turn off
DEP for, and then click OK.

If the program is not in the list, click Add. Browse to the Program Files folder, find the executable file for the
program (it will have an .exe file name extension), and then click Open.

Click OK in the System Properties dialog box if it appears, and then click OK again. You might need to restart
your computer for the changes to take effect.

Note

To turn on DEP for a program, clear the check box next to the program that you want to turn on DEP for, and
then click OK.


